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1 Preface
1.1 Documentation Overview
This section provides an overview of the R&S NRPV user documentation. Unless
specified otherwise, you find the documents on the R&S NRPV product page at:
www.rohde-schwarz.com/manual/nrpv

1.1.1 User Manual and Help
Introduces the R&S NRPV and describes how to set up and start working with the
product. Includes basic operations and measurement examples. Contains also the
description of all application modes and functions.
The contents of the user manuals are available as help in the R&S NRPV. The help
offers quick, context-sensitive access to the complete information for the base unit and
the software options.
The user manual is also available for download or for immediate display on the Internet.

1.1.2 Data Sheets and Brochures
The data sheet contains the technical specifications of the R&S NRPV. It also lists the
options and their order numbers, and optional accessories.
The brochure provides an overview of the instrument and deals with the specific characteristics.
See www.rohde-schwarz.com/brochure-datasheet/nrpv

1.1.3 Release Notes and Open Source Acknowledgment (OSA)
The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.
The open source acknowledgment document provides verbatim license texts of the
used open source software.
See www.rohde-schwarz.com/software/nrpv

1.1.4 Application Notes, Application Cards, White Papers, etc.
These documents deal with special applications or background information on particular topics.
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See www.rohde-schwarz.com/application/nrpv

1.2 About this Manual
This User Manual describes general functions, the operation and all settings of the
application.
The following topics are included:
●

Chapter 2, "Welcome to R&S®NRPV...", on page 7 introduces to the virtual
power meter software R&S NRPV.

●

Chapter 3, "System Setup", on page 9 provides information required to prepare
the application for power measurement. The chapter covers soft- and hardware
requirements, describes how to install the software on a computer and how to get
the application started.

●

Chapter 4, "Quick Start Guide", on page 24 covers a short description of the
application and some basic information about power measurement. To quickly get
started, a step-by step procedure describes how to perform a continuous average
measurement.

●

Chapter 5, "Operating Concept", on page 47 introduces the operating concept
with the basic components of the graphical user interface and how to operate.

●

Chapter 6, "Settings - GUI Reference", on page 69 describes menus and functions of the application in detail.

●

Chapter 7, "Appendix", on page 171 provides an index and makes familiar with the
conventions used in this manual. It covers information on warning messages and
R&S information for customer support and service.

1.3 Typographical Conventions
The following text markers are used throughout this documentation:
Convention

Description

"Graphical user interface elements"

All names of graphical user interface elements on the screen, such as
dialog boxes, menus, options, buttons, and softkeys are enclosed by
quotation marks.

[Keys]

Key and knob names are enclosed by square brackets.

Filenames, commands,
program code

Filenames, commands, coding samples and screen output are distinguished by their font.

Input

Input to be entered by the user is displayed in italics.

Links

Links that you can click are displayed in blue font.

"References"

References to other parts of the documentation are enclosed by quotation marks.
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2 Welcome to R&S®NRPV...
… the power meter software application for R&S Instruments
This chapter gives an introduction to the Virtual Power Meter, including main features,
scope and system overview.

2.1 Introduction
The power meter software application R&S NRPV represents power measurement for
the most relevant frequency bands and power classes. By communicating with R&S
NRP-Zxx and R&S NRPxxS(N) sensors the program covers a wide range of applications. Besides the basic continuous average measurement function, R&S NRPV also
includes the measurement modes timeslot, burst and scope measurement.
The R&S NRP-Zxx and the R&S NRPxxS(N) are highly accurate standalone measuring instruments. With their internal CPU the power sensors process the measurement
results and communicate directly with a PC via an USB connection. Additionally, the
R&S NRPxxSN, the so called network sensors, are equipped with a Gigabit Ethernet
interface with Power-over-Ethernet (PoE) power supply.
With a high dynamic range and automatic error correction the power sensors are suitable for nearly every measurement task. As an example, among other duties, the NRPZ81 is able to measure pulse parameters automatically, and the R&S NRPV software
represents the results.
For measurements with any number of power sensors the graphical user interface of
R&S NRPV offers functionality and operation comparable to a multi-channel oscilloscope.

2.2 Main Features
R&S NRPV supports all sensor features and settings in the following measurement
modes:
●

Trace measurement for representing signal power in the time domain. If you are
working with an NRP-Z8x power sensor, for example, the R&S NRPV also supports
pulse analysis.

●

Numerical measurement modes as:
–

Continuous mode to measure the average power of continuous signals

–

Burst mode to analyze pulsed signals. R&S NRPV automatically recognizes
the start and end of a burst. It is possible to exclude pulse build up and decay
phases, for example to omit signal overshoots.

–

Timeslot mode to display the values in a defined time segment. The start and
stop of a pulse signal can be excluded optionally, for example to fade out slow

User Manual 1173.0314.02 ─ 07

7

R&S®NRPV

Welcome to R&S®NRPV...
Scope of Applications

edges. It is also possible to exclude time domains during measurements, for
example if power fails in certain ranges.
–

Gates mode to exclude time segments during measurement

–

Statistics measurements to evaluate the ratio of the signal density/distribution
versus power

You can view the measurement results directly, or represent ratios of various traces,
and even record and store measurements over a long term. R&S NRPV indicates the
measurement results numerically as well as graphically.
In addition, you can setup several measurements in parallel. While a measurement is
active, the others are in standby state, and you can quickly and easily switch between
them.

2.3 Scope of Applications
The R&S NRPV covers apart from other functions the following fields of application:
●

Test setups and procedures for power amplifiers

●

Measurement of the frequency and/or level response

●

Fast measurement of the transmission characteristics of filters, amplifiers and
frequency converters over a large frequency and dynamic range

●

Measurement of radar systems and their components

●

Measurements compliant with major communication base station standards such
as GSM, WCDMA, etc.
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3 System Setup
System setup provides information required to prepare the application for power measurement. The chapter contains soft- and hardware requirements, describes how to
install the software on a personal computer and how to get started.
The Virtual Power Meter is provided free of charge on the internet at the download site
of Rohde & Schwarz:
http://www.rohde-schwarz.com/product/NRPV.html
For using the R&S NRPV with the R&S NRPxxS(N) no license key is needed. You can
use the R&S NRPV and all its functions for free.
Power measurements with an R&S NRP-Zxx series power sensor are activated by purchasing a license key for each sensor.
Contact the R&S sales department for purchase. The license key comes with an
instruction to activate the power sensor in the Virtual Power Meter.

3.1 Hardware
For controlling the sensors by a PC the following hardware prerequisites must be fulfilled
Table 3-1: Hardware requirements
Minimum requirement
CPU

Pentium IV 1 GHz or higher

RAM

1 Gbyte

Hard disk

50 Mbyte free space

Monitor

XGA monitor (1024 x 768)

Interfaces

USB 1.1 or USB 2.0

3.1.1 Accessories (optionally)
●

High-speed hubs for USB 2.0 with own power supply for connecting several power
sensors. For information on recommended USB hubs refer to Chapter 3.4.3, "R&S
NRP-Zxx Multiple Measurement Setup", on page 15

●

NRP-Z3, active USB adapter cable 3 (only for R&S NRP-Zxx Power Sensors)
Supports applications that require external triggering of the power sensor, and provides separate power supply.

●

NRP-Z4, passive USB adapter cable (only for R&S NRP-Zxx Power Sensors)
Supports all basic functions of the sensors like transmission of settings, measurement data and provides power supply of the sensor via the USB bus.

●

NRP-Z2, extension cable (only for R&S NRP-Zxx Power Sensors)
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Cables of various lengths support test setups with distant sources of up to 10
meters.
●

NRP-Z5, 4 port USB hub adapter box
The NRP-Z5 Sensor Hub covers a high-speed USB 2.0 hub. This sensor hub
allows to connect up to four R&S NRP-Zxx Power Sensors, and supports various
trigger modes, such as:
–

bidirectional triggering from a host, like a PC or an R&S instrument

–

internal triggering

–

external synchronous triggering

–

triggering in master mode together with the NRP-Z8x sensors.

Connection to a sensor is possible with the USB adapter cable NRP-Z4 and with
cable extension NRP-Z2.
The NRP-Z5 can be connected to a PC either with the NRP-Z4 adapter cable, or
with a standard USB cable. Separate power supply is not required.
●

NRP-ZKU cable with a USB connector (only for R&S NRPxxS(N))
Cables of various lengths for connecting the R&S NRPxxS(N) power sensors to
USB devices.

●

NRP-ZK6 cable with a push-pull type connector (only for R&S NRPxxS(N))
Cables of various lengths for connecting the R&S NRPxxS(N) power sensors to
supported Rohde & Schwarz instruments.

3.2 Software
The Virtual Power Meter software runs on PCs with Microsoft®Windows operating system.
R&S NRPV is available free of charge. You can find the program file
NRPV_SetupV1.x.y.exe
for download on the Rohde & Schwarz website:
http://www.rohde-schwarz.com/product/NRPV.html
x and y are sub-version and build numbers.

3.2.1 R&S NRPV Software Components
The setup program contains all components required for installation and operation of
the R&S NRPV.
●

RS_NRPV.exe the executable application file

●

ReleaseNotes.txt with up-to date notes on the individual components and software versions.

●

Microsoft® Runtime vcredist_x86.exe
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3.2.2 Power Sensors Firmware
Since R&S NRPV works closely leant on the functionality of the power sensors, the
program checks the firmware version of every connected sensor, and returns a list of
the sensors that require a firmware update.

To update the sensor firmware, use the R&S NRP-Toolkit. You find the latest firmware
version in the download area of the R&S website:
http://www.rohde-schwarz.com/en/product/nrpz.html
http://www.rohde-schwarz.com/en/product/nrp_s_sn.html
Table 3-2: Required firmware versions
Minimum
NRP-Z1x

V4.13 or later

NRP-Z2x

V4.13 or later

NRP-Z3x

V4.13 or later

NRP-Z5x

V4.13 or later

NRP-Z8x

V1.31.04 or later

NRP-Z9x

V4.13 or later

NRPxxS/ NRPxxSN

V14.12 or later

3.3 Installing R&S NRPV Virtual Power Meter Software
This section describes the installation of the R&S NRPV software on a Microsoft®Windows based PC. Additionally, the section contains information on the software packages, prerequisites and uninstalling.
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Prerequisites
●

Use the latest version of the R&S NRPV software. It is provided at the R&S website
http://www.rohde-schwarz.com/product/NRPV.html.

●

Close all running applications before installing.

3.3.1 Installing R&S NRPV

R&S NRPV requires at least 50 MB of free disk space.

1. Download the latest version of the R&S NRPV setup program from the R&S website http://www.rohde-schwarz.com/product/NRPV.html.
2. Execute NRPV_SetupV1.x.y.exe, and follow the instructions of the setup wizard.
During installation, the setup program:
●

Installs the "Microsoft VC Runtime libraries", which may take some time

●

Provides selection of the destination directories for the R&S NRPV application files

●

Checks whether a current version of the NRP-Toolkit is installed on the computer. If
this is not the case a message will appear:

The NRP-Toolkit can be downloaded for free on the R&S website:
http://www.rohde-schwarz.com/en/software/nrp_s_sn/
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3.3.2 Uninstalling R&S NRPV
Uninstall a version of R&S NRPV with the aid of the PC´s control panel:
1. In the Windows task bar, "Start > Settings > Control Panel"
2. Select "Add or Remove Programs".
3. In the dialog, select Virtual Power Meter V1.x.y (x.y. represents the version).
4. To uninstall the program, select "Uninstall".

3.4 Connecting an R&S Power Sensor to the PC
This section shows some basic test setups and the cabling.

Putting the Power Sensors into Operation
●

Functions and features your power sensors are described in the corresponding
operating manual of the sensor, included in delivery.

●

To prevent damage to the sensor, follow closely the instructions, how to put the
sensor into operation.

●

Make sure that all sensors are connected to the PC (either directly or via USB
hubs) when starting R&S NRPV. For Information on how to check that a power
sensor is working properly see Chapter 3.7.2, "Check if a power sensor is working
properly", on page 22

If an R&S NRP-Zxx Power Sensors is being connected to the PC the first time, the
application installs the USB driver for the sensor automatically. USB drivers for the
power sensors are provided with the R&S NRP-Toolkit.

3.4.1 Connecting the R&S NRPxxS(N) to a PC
There are different ways for connecting the R&S NRPxxS(N) power sensors to a PC.
For a description of this setups refer to the user manual of your sensor.
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3.4.2 R&S NRP-Zxx Single Measurement Setup

Figure 3-1: Measurement setup with a passive adapter cable NRP-Z4

Figure 3-2: Measurement setup with an active adapter cable NRP-Z3

1. Connect the R&S NRP-Zxx Power Sensors with the USB port of the PC using the
NRP-Z3 or NRP-Z4 adapter cables.
2. Connect the signal source (DUT - Device Under Test) and the power sensor.
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3.4.3 R&S NRP-Zxx Multiple Measurement Setup

Figure 3-3: Multiple measurement setup with a USB 2.0 hub

If an application works with more than one R&S NRP-Zxx Power Sensors, you probably need a USB hub. It is recommended that you use an NRP-Z5 Sensor Hub which
perfectly fits to R&S power sensors.
1. Connect the R&S NRP-Zxx Power Sensors and the USB hub using the NRP-Z3 or
NRP-Z4 adapter cables
2. Connect the USB hub's upstream port with a USB port of the PC.
3. Connect the signal sources and the power sensors
The following section provides additional information related to the USB interface and
information on operating multiple sensors simultaneously.
Multiple Sensors
If multiple sensors need to be connected to one computer, make sure that the USB
device can provide the required amount of current for all sensors. A sensor may need
between 300 mA and 500 mA.
Example:
The NRP-Z81 sensor needs up to 500 mA supply current. Using 4 sensors simultaneously on one USB hub requires a total current of at least 2 Amperes.
Even if the rated current values are given in the data sheets, commercially available
USB hubs often do not reliably provide this amount of supply current over a long period
of time.
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It is recommended that you use the NRP-Z5 sensor hub, a 4 port USB hub adapter
box, which perfectly fits to R&S NRP-Zxx Power Sensors.
Otherwise, for industrial-grade applications USB hubs for DIN rail mount can provide
up to 1 Ampere per USB port and run off a 24 V power supply.
The following manufacturers provide such devices:
●

Beckhoff http://www.beckhoff.com CU8005

●

Luetze http://www.luetze.de 745581 DIOHUB USB 4

3.4.4 R&S NRP-Zxx Complex Measurement Setup

Figure 3-4: Complex measurement setup with a 4 port USB hub adapter box NRP-Z5

1. Connect the plug in power supply
2. Connect the external trigger source
3. Connect the R&S NRP-Zxx Power Sensors and the USB hub using the NRP-Z3 or
NRP-Z4 adapter cables
4. Connect the signal sources and the power sensors
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3.5 Starting the R&S NRPV Software
License required
For using the R&S NRPV with the R&S NRPxxS(N) no license key is needed. You can
use the R&S NRPV and all its functions for free.
Power measurement with R&S NRP-Zxx Power Sensors and R&S NRPV requires a
license key for activating the sensor. Contact the R&S sales department for purchase.
If you have already purchased license(s), refer to Chapter 3.6.1, "Activating with
License", on page 19 for activating your sensor in the R&S NRPV.
If a sensor is connected without a license, you can activate the sensor temporarily, for
example, to explore the functionality of the software. See Chapter 3.6.2, "Activating
without License for Temporary Use", on page 20.
To start the R&S NRPV perform one of the following:
●

In the Windows taskbar, select "Start > Programs > NRPV Virtual Power Meter >
NRPV Virtual Power Meter"

Figure 3-5: Start R&S NRPV

●

On the desktop, select the "R&S NRPV" icon.

Figure 3-6: R&S NRPV Desktop icon

The icon has been automatically created during installation.
●

In the Windows Explorer, select
%PROGRAMFILES%\Rohde-Schwarz\RS_NRPV.exe, where %PROGRAMFILES%
is a system variable and refers to the directory, programs are installed in.

Immediately after turning on the start screen appears until the application is ready for
operation. The application opens in a specific preset configuration, see Chapter 6.2.2,
"Startup Configuration", on page 73.
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Figure 3-7: Startup Screen

R&S NRPV Startup Configuration
In this dialog you can select the following startup configuration:
●

The last active state

●

A user definable mode, specified in a task file.

●

Default settings

3.6 Activate an R&S NRP-Zxx Power Sensors in
R&S NRPV
While the R&S NRPxxS(N) series of USB power sensors contain an activation key for
the NRPV as a factory default, the R&S NRP-Zxx series power sensors need to be
activated for the use with NRPV.
If you have already purchased a license key for your R&S NRP-Zxx sensor, proceed as
described in the following section. Alternatively, you can activate a sensor without a
license temporarily, to explore the functionality and scope of the Virtual Power Meter.
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3.6.1 Activating with License
In the delivery you find a license key that unlocks your NRP-Zxx sensor in the
R&S NRPV. If you want to perform tasks with several power-sensors, you need a
license key for each sensor.
To activate the sensor, proceed as follows:
1. Start R&S NRPV and first connect the sensor.
2. In the "File" menu, select "File > Licensing"

Figure 3-8: File > Sensor licensing

The "Licensing NRP-Z Power Sensors for NRPV" dialog opens.

Figure 3-9: Licensing NRP-Z Power Sensor for R&S NRPV

The dialog indicates all currently connected sensors for selection.
3. Select the sensor.
4. Select "Enter License".
The "License Activation" dialog opens.

Figure 3-10: License Activation
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5. Enter the license key either manually or with the key code file.
6. Confirm with "OK" to return to the "Licensing NRP-Z Power Sensors for NRPV" dialog.

Figure 3-11: Licensing NRP-Z Power Sensor for R&S NRPV > completed

Are there still sensors listed, repeat the process for each one, provided you have
the appropriate number of licenses.
The "<No unknown sensor found>" message confirms that no unlicensed sensor is
connected.
All sensors are enabled and ready for operation with R&S NRPV

3.6.2 Activating without License for Temporary Use
If you want to evaluate the R&S NRPV before buying a license for your R&S NRP-Zxx
Power Sensors:
1. In the "File" menu, select "File > Licensing"
The "Licensing NRP-Z Power Sensors for NRPV" dialog opens.
2. Select "Evaluate Without License…"

Figure 3-12: Licensing NRP-Z Power Sensor for R&S NRPV > evaluate without license

The "Input Text" dialog opens and displays a code sequence for activation.
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Figure 3-13: Licensing NRP-Z Power Sensor for R&S NRPV > code without license

The code is generated randomly and changes with each new call.
3. Enter the displayed "Code" string exactly as shown in the "Input Text" dialog box.
The coding is case sensitive.
4. Confirm with ok.
This function activates your power sensor for a period of time.
Power sensors which are enabled temporarily show a thin red bar beneath their
icon in the program’s status bar. The length of this bar decreases until the evaluation period is expired.

3.7 Troubleshooting for Setup Related Problems
This chapter contains information to possibly arising problems concerning restrictions,
the USB interface or if several sensors are attached.

3.7.1 Known Restrictions
Only one instance of R&S NRPV can run at a time, multiple program invocation is not
supported. At program start, a test routine checks if any other instance is already running. If the program is started twice, a warning message appears.

Figure 3-14: Single instance warning

A simultaneous operation of R&S NRPV with other software using the R&S power sensors (for example R&S Power Viewer Plus) is also not supported.
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3.7.2 Check if a power sensor is working properly
1. On the desktop, select "Start > Settings > Control Panel".

Figure 3-15: Settings > Control Panel

2. Select the "System Properties" dialog.

Figure 3-16: System Properties

3. In Hardware tab select "Device Manager."
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Figure 3-17: Device Manager

If the power sensor and its drivers are installed and working properly, it is listed in
the "R&S NRP-Z Power Sensors" section of the "Device Manager". If an unknown
device is shown instead, check the items listed in the Chapter 3.7.3, "USB Related
Problems", on page 23.

3.7.3 USB Related Problems
Hardware
●

Use only high-speed hubs with own power supply.

●

Disconnect the power supply of the hub when switching off the computer. Connect
the hub's power supply before starting Microsoft®Windows.

●

Do not cascade hubs unnecessarily.

●

Use only connection cables of high speed USB 2.0 hubs.

●

Exchange hub if all points above are not successful.

Software
●

●

Use one of the supported Microsoft®Windows operating systems:
–

Microsoft®Windows XP with the latest available service pack for Microsoft®Windows XP, i.e. SP2

–

Microsoft®Windows Vista

–

Microsoft®Windows 7

–

Microsoft®Windows 8/8.1

Use the latest version of the R&S NRP-Toolkit software (version 4.4.0 or higher,
available at http://www.rohde-schwarz.com/en/software/nrp_s_sn/
under Downloads > Firmware/Software).
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4 Quick Start Guide
This section introduces the graphical user interface and contains some basics to power
measurement.
An instruction to perform a standard continuous average power measurement takes
you step-by-step through the information required, to get used to the R&S NRPV basic
modes of operation.
The Quick Start Guide contains:
●

Chapter 4.1, "GUI Overview", on page 24
Describes briefly the main components of the user interface. In general, the
menus, dialogs and functions are largely self-explanatory. Characteristics to specific applications or settings are explicitly stated.
For detailed information on every item of the GUI refer to Chapter 5.1, "Graphical
User Interface (GUI)", on page 47.

●

Chapter 4.2, "Basic Information on Power Measurement", on page 29
Contains some information on power measurement for RF and microwave signals.

●

Chapter 4.3, "Performing a Measurement with R&S NRPV", on page 31
Describes how to get started by selecting the power sensor, the signal channel,
configuring the test signal and results display.

4.1 GUI Overview
Starting the R&S NRPV software the main application window opens. The appearance
is based on the Microsoft®Windows layout. Measurements are displayed in additional
windows. The appearance of those windows varies, depending on the measurement
mode and the required settings.
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4.1.1 Windows
Main Application window

Figure 4-1: Main application window of R&S NRPV

The main window of the application covers a menu bar with several pull-down menus
and a toolbar with icons of the most important functions. Similar to Microsoft®Office
functionality, the icon buttons are the alternative possibility for starting a function. The
status bar informs about the connected power sensors and the currently active tasks.
Measurement windows
Measurement windows look different depending on the measurement mode. It is distinguished between numerical and graphic measurement windows.
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Figure 4-2: Numeric measurement window of R&S NRPV

Figure 4-3: Trace window of R&S NRPV

Measurement windows are tiled in several sections.
In the display area, you can graphically display the measurement results. On the right
the control panel provides softkeys for accessing further dialogs and entry fields with
measurement related settings. In the lower area of the window, measurement panels
indicate numerical measurement results.
Additionally, you can open a context-sensitive menu within each results display, also
providing access to further functions.
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4.1.2 Dialogs
Configuration dialogs are designed in Microsoft®Windows format, covering the same
main elements, as e.g. tabs, entry fields, check boxes or buttons. Each dialog provides
buttons to apply, confirm or cancel the entered settings
Configuration dialog

Figure 4-4: Configuration dialog

Configuration dialogs cover entry fields for measurement related settings.

4.1.3 Menus
The menu bar of R&S NRPV contains the main menu items. Some items include submenus with additional functions.

Figure 4-5: Menu bar

The following main menus are available:
●

File: Contains all functions that belong to file management.

●

Configure: Contains basic parameters for configuring a measurement, such as frequency, channel settings or predefined digital communication signals. In addition,
you can determine the colors for displays and curves individually.

●

Trigger: Contains the functions for setting the parameters of externally connected
trigger sources.

●

Measure: Menu for selecting the measurement mode.

●

Zero: Menu for zero error correction.

●

Window: Menu containing the functions for window handling.
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●

Help: R&S NRPV Help.

► To access a menu use the mouse or the [ALT+<key>] combination on the keyboard.

Figure 4-6: Standard menu

Within the results display of a measurement window, you can also access the configuration dialogs or additional functions via context-sensitive menus.
► To access a context-sensitive menu, right click in a measurement window.

Figure 4-7: Context-sensitive menu

See Chapter 5.1.4.2, "Context-sensitive Menus", on page 60 for detailed information.
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4.1.4 Toolbar

Figure 4-8: Toolbar

The toolbar of the main application window covers icons of the most important functions.
► To start a function of the R&S NRPV toolbar, perform one of the following:
●
●

In the toolbar, select the corresponding icon.
On the keyboard, use the associated shortcut.

Each icon features a corresponding item in the menu lists. For detailed assignment on
icons and shortcuts to the corresponding functions see Chapter 5.1.5, "Icons, Toolbar
and Shortcuts", on page 61.

4.2 Basic Information on Power Measurement
The following sections contain some basics to power measurement for RF and microwave signals.
Some contents of the following sections are taken from the R&S brochure 'Voltage and
Power Measurements - Fundamentals, Definitions, and Products'. You can find the
brochure for download on the R&S Website http://www.rohde-schwarz.com/en/product/
nrpz.html
.

4.2.1 Introduction
The intensity of RF and microwave signals is given in terms of power. Therefore, measuring electrical power is significant for RF and microwave applications.
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With the development of carrier-based telecommunications also the measurement of
power, voltage and current has improved. Mainly based on converting electrical energy
into heat, direct voltage and current measurement can be made up into the GHz range.
Voltage and current are less appropriate because they depend on the physical characteristics of the transmission medium and field strength. They differ for the same transmitted power. Also, voltage and current can not directly be measured in waveguides
and for standing waves large measurement errors occur.
The rate of energy flow, power, is the absolute measurable value of the wave intensity.
In high frequencies ranges the wavelength of the electromagnetic field affects the wave
properties and characteristics, caused by lines and subassemblies. To be taken into
account for power measurement, wavelength and magnitude of the electromagnetic
field are of the same order as the signal wavelength. Additionally, all components in a
power transmitter or amplifier, e.g. the AC line connector, the cooling system or coaxial
RF output, depend on the magnitude of the RF power.
Besides the effects mentioned above, several critical factors may cause errors in the
measurement of RF power. For instance, the loading effects of measuring equipment
on the DUT, inherent physical factors or unsuitable probes may increase measurement
uncertainty.
To carry out a power measurement correctly, it is essential to assort the most appropriate measurement equipment for the respective application. For a wide variety of tasks
Rohde & Schwarz provides suitable power meters and power sensors.

4.2.2 Definition of Electrical Power
Power is defined as the amount of energy absorbed or transferred in a system per unit
of time. The power transmitted across an interface is then the product of the instantaneous values of current and voltage at that interface.
p(t) = v(t) x I(t)
For sinusoidal signals encountered in RF and microwave engineering, the instantaneous power p(t) oscillates about the average power at a frequency that is twice that of
the original waveform. Only the average power can be measured in practice and is
referred to as power P. P is referred to as active power and is related to the RMS voltage V, the RMS current I and the phase φ by the following equation:
P = V x I x cosφ
For modulated sinusoidal signals the average of P over the modulation period is
called the average power Pavg
This power e.g. is indicated by a thermal power meter (sensor).

4.2.3 Units and Power Level
Electrical power is measured in W [Watt]. Because of the large power ranges that have
to be measured, values are usually expressed as the log of a power ratio. A relative
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power level Ly is expressed in terms of the log of the ratio of a power P to an arbitrary
reference power P0. The units of the power ratios are dB.
Ly = 10 log10 (P/P0) dB
Labs = 10 log10 (P/P0) dB
The absolute power level Ly refers to 1 mW and is measured in dBm:
Labs = 10 log10 (P/1 mW) dB
P = 1 x 10 Labs/10dBm mW
See the following list of the corresponding absolute and relative power level values in
the range 1018:
Table 4-1: Units and power level
Power P

Level Labs [dBm]

Power Ratio

1 pW

-90

10-9

1 nW

-60

10-6

1 µW

-30

10-3

0.1 µW

-10

0.1

0.25 mW

-6

0.25

0.5 mW

-3

0.5

1 mW

0

1

2 mW

+3

2

4 mW

+6

4

10 mW

+10

10

100 mW

+20

100

1W

+30

103

1 kW

+60

106

1 MW

+90

109

4.3 Performing a Measurement with R&S NRPV
This section describes briefly how to basically set up a power measurement, by using
an R&S signal generator as signal source and a power sensors as the measuring
instrument.
Because the power measurement system is to be terminated, the power sensor also
acts as the load, set up without external triggering and power supply. Source and load
are connected to a standard coaxial transmission line with the characteristic impedance. The signal source generates an RF test signal. The R&S NRPV indicates the
signal power measured by the power sensor. The sensor runs with continuous initiali-
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zation enabled and thus sends measurement results without waiting for any trigger
events.
In continuous average mode the average signal power is continuously measured without the measurement window and the signal being synchronized.
During the measurement period, samples are measured at equal intervals. The results
of two adjacent measurement windows are combined. The average of both is either
output as the final result or used as an intermediate result for further averaging.
Not all power sensors support all of the examples described below.

4.3.1 Setting up the measurement
1. Check that the required system components are available as listed below:
●
●
●
●

PC
R&S Power Sensor (e.g. R&S NRP-Z81)
R&S Signal Generator
passive adapter cable R&S NRP-Z4 for the R&S NRP-Zxx sensors or NRPZKU cable for the R&S NRPxxS(N) sensors

2. Check that the system is setup as required.
For the R&S NRP-Zxx power sensors set up the measurement system as described in Chapter 3.4.2, "R&S NRP-Zxx Single Measurement Setup", on page 14
For the R&S NRPxxS(N) power sensors set up the measurement system as described in the user manual of the sensor.
3. Check that the PC is ready for operation. It is assumed that all software components are installed as described in Chapter 3.3, "Installing R&S NRPV Virtual
Power Meter Software", on page 11.
4. Switch on the R&S Signal Generator.
5. To start R&S NRPV on the PC, select "Start > Programs > RS-NRPV > Virtual
Power Meter"
6. Check if the power sensor has reached its operating temperature.

4.3.2 Generating the Test Signal
An RF signal with 1 GHz and 0 dBm level is generated, in accordance with the digital
signal standard GSM, a worldwide used TDMA standard for cellular mobile radio networks.
For setting the signal parameters on your generator, proceed as follows:
1. Activate default (preset) state for starting from a known position.
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2. Select and activate digital standard signal.
3. Set the signal level and frequency.
4. Activate the signal output.

4.3.3 Measuring the Average Power

4.3.3.1

Configuring the Channel, Sensor and Signal Frequency

Configure the channel settings
To configure the channel settings, perform the following steps:
1. Select "Configure > Channel Assignment"

Figure 4-9: Context-sensitive menu

Figure 4-10: Channel assignment dialog

2. In the "Channel Assignment" dialog, assign a short name to a channel
By default, each channel is denoted by capital letters.
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Figure 4-11: Channel assignment > assigned name

At a maximum you can assign three letters, as for example "IN" or "OUT". Right
next, to the channel, R&S NRPV shows the sensor type, its serial number and connectivity of the connected sensor.
Note: With one power sensor connected R&S NRPV automatically assigns the
power sensor to channel A.
In case more sensors are connected, proceed as follows:
a) Select the channel intended for measurement.
b) Assign the short name OUT.
c) Select "Apply" to assign the selection.
Skip these steps if the channel is already activated.
d) Close the dialog with "OK".
Initializing the power sensor
To prevent any previous settings from causing incorrect results always run a new measurement with reset of the sensor.
To initialize the power sensor, proceed as follows:
1. Turn off the test signal before zeroing.
An active test signal during zeroing causes an error because the measured power
is too high.
2. Select "Zero > Select > OUT" (channel short name)

Figure 4-12: Zero channel

Zeroing starts in channel "OUT". This procedure checks the confidence level of the
sensor results.
Zeroing takes several seconds. At run time a "Zeroing in progress..." message
pops up. When completed the message terminates zeroing successfully or reports
an error (Success / Failed).
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Figure 4-13: Zeroing in process

Setting the frequency
The carrier frequency of the applied signal must be set for reaching the specified measurement accuracy.
1. To set the frequency, select "Configure > Signal Frequency...".

Figure 4-14: Configure > Signal frequency

Figure 4-15: Signal frequency dialog

The "Signal Frequency" dialog opens, where you can determine the signal frequency. The frequency value of the selected channel is indicated.
2. Select the channel.
3. Enter 1.0 GHz signal frequency.
Tip: Use a dot as decimal separator.
4. Select "Apply" to assign the entry.
5. Close the dialog with "OK".
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4.3.3.2

Configuring the Measurement Window

Setting up the measurement window
A measurement comprises at least two measurement windows, i.e. 2 x aperture time
and a sensor specific dead time of up to 100 µs.
By default a power sensor is set to an aperture time of a few microseconds to minimize
the inherent noise component in the measurement result. For an unmodulated signal,
as it is in this example, the default setting of 10 µs in conjunction with chopper stabilization provides optimum noise suppression.
To set up a continuous average measurement window, proceed as follows:
1. In the menu bar, select "Configure > Continuous".

Figure 4-16: Configure > Continuous

Opens the Continuous Average dialog to enter the aperture time and to activate
smoothing.

Figure 4-17: Configure Continuous > Aperture time

2. Select the channel.
3. In the "Aperture" entry field, enter 10 µs.
The aperture time defines the size of the measurement window. The aperture time
of the selected channel is indicated.
4. Select "Apply" to assign the entry.
5. Close with "OK."
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4.3.3.3

Execute Measurement

1. Start the measurement
a) To start the measurement, switch on the test signal of the signal source.
b) In the menu bar, select "Measure > Continuous".

Figure 4-18: Measure menu

The "Continuous" measurement window appears. It is shows the measurement
results numerically, and the control panel for accessing further dialogs with parameters for measurement, evaluation and display.

Figure 4-19: Continuous window

The measurement result is displayed in dBm as the default unit setting for continuous average power measurement.
2. Change the unit of the measurement result.
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a) In the "Continuous Window", select "Meas..." to open the "Measurement Configuration" dialog.

Figure 4-20: Configuration > Continuous window

b) Select the "Unit" tab in the lower area of the dialog.
c) Select "W" in the "Absolute" selection list.
d) Click "Apply" to assign your entry and confirm with "OK".

Figure 4-21: Continuous window > results in [Watt]

The measurement result is displayed in [W].
3. Set a fixed offset correction.
If the signal level is higher than the permissible input level of the sensor, an attenuator is connected between the signal source and the sensor, to prevent the sensor
from damage. In order to adjust the attenuation, an offset correction value must be
set. This value compensates the difference between the real signal level and the
level at the sensor´s input. The indicated value corresponds to the real signal level.
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a) In the menu bar, select "Configure > Channel Settings".

Figure 4-22: Configure > Channel settings

b) Select the channel.

Figure 4-23: Channel settings dialog

c) In the "Offset" section, select "Global".
d) Enter the associated attenuation value.
e) Select "Apply" to assign your entry and confirm with "OK".
Note: To make sure, that the devices perfectly match, it is recommended that
you only use an R&S attenuator.
4. Measure power relative to a reference value.
The R&S NRPV calculates and displays relative differences between a measured
value and a reference value. As a reference, you can use a previously stored
value, or you can specify it directly.
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a) In the "Continuous Window", select "Meas..." to open the "Measurement Configuration" dialog.

Figure 4-24: Configuration > Continuous > Unit

b) In the "Unit" tab, select "dBm" for the absolute value.
c) In the "Relative" tab, activate the "Relative".
d) Enter -10 dBm "Ref. Value".

Figure 4-25: Configuration > Continuous > Relative
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e) Select "Apply" to assign your entry and confirm with "OK".

Figure 4-26: Continuous window > reference value indication

The diagram indicates the set reference value and the measured value relative to
this reference, in this example -10 dBm. That means, the level of the applied signal
is -26 dBm. The relative difference between the measured value and the -10 dBm
reference value is -16 dBm.
5. Configure the display
a) In the "Continuous Window", select "Display..." to open the "Display Configuration" dialog.

Figure 4-27: Display Configuration > continuous window name

In this dialog, you can assign a name window name.
b) Enter the name, for example 1 GHz, GSM - Continuous Av.
c) Select "Apply" and confirm with "OK".

Figure 4-28: Continuous window > window renamed
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4.3.3.4

Graphically representing power versus time
Trace and statistics modes represent graphically the measured power versus time. Displaying the signal graphically as with an oscilloscope, trace mode is particularly suitable for recognizing stable triggering of modulated signals during measurement.
Set the trace mode
1. Apply an amplitude-modulated or pulsed signal with a modulation or pulse frequency of 1 kHz and 0 dBm signal level.
2. To configure trace mode, select " Measure > Trace" in the menu bar.
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Figure 4-29: Select trace mode

Figure 4-30: Trace window
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Opens the "Trace" window . It is shows the measured signal power graphically. The
control panel provides access to settings dialogs for configuring the trace, mathematic functions, the diagram and marker. Additionally, you can configure the display settings like scale, power, time and trigger. In the lower area of the window,
the measurement panel indicates numerical measurement results. For detailed
description on trace measurement and the associated functions see Chapter 6.4.2,
"Trace", on page 97.
4.3.3.5

Math Configuration
"Math Configuration" includes operands selection for math measurement of maximum
of four math channels, math operation selection, math channel selection for view, relative measurement option and reference value, Selection of units and resolution, and
the parameters that shall be displayed as auxiliary.

Figure 4-31: Math configuration dialog

Figure 4-32: Continuous window > math results indication

The R&S NRPV automatically tiles the window and shows the math results.
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4.3.4 Numerical Burst Average Measurement
The burst average mode is used to measure the average power of pulsed signals. In
this example, a pulsed RF signal with a pulse repetition frequency not exceeding
10 kHz is used. The sensor automatically detects start and end of a burst and the trigger point from the measured signal. An external trigger is not required.
1. Set the measurement window.
a) Select "Configure > Burst Average..." in the menu bar.

Figure 4-33: Configure > Burst Average

Opens the "Burst Average" dialog for configuring the burst mode parameters.
Exclude from start and Exclude from end exclude pulse build-up and decay
phases of a pulse. Dropout increases the reliability of the end of the modulated
burst signal.
The values of the selected channel are indicated.

Figure 4-34: Configure > Burst Average dialog

b) Select the measurement channel.
c) Enter "Exclude From Start" 0.001 s.
This parameter excludes initial peaks of the signal from the measurement.
d) Enter "Exclude From Start" 0.002 s.
This parameter excludes fluctuations at the falling edge of the burst from the
measurement.
e) Select "Apply" to assign you entries and confirm with "OK".
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2. To start the measurement, select "Measure > Burst Average" in the menu bar.

Figure 4-35: Continuous window > Burst Av results indication
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5 Operating Concept
Operating concept describes the layout of the application windows, display, controls
and how to operate R&S NRPV.

5.1 Graphical User Interface (GUI)
Starting the R&S NRPV software opens the main application window. The appearance
is based on the Microsoft®Windows layout. At the top the window covers a menu bar
with several pull-down menus and a toolbar with icons of the significant functions. Similar to Microsoft®Office functionality, the icon buttons are the alternative possibility for
starting a function. A status bar at the bottom covers information on the connected
power sensors and the currently active tasks.

Figure 5-1: Operating concept > Graphical User Interface

Operation corresponds to windows user interfaces. All menus, dialogs and tables are
made up of known elements, such as selection lists, check boxes and entry fields. A
frame indicates an active item. Highlighted elements are in edit mode.
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5.1.1 Particular Features

5.1.1.1

Zoomed out results display

Convenient monitoring of individual readings
By double-clicking a value in a measurement panel, you can zoom out the value and
leave it permanently indicated on the display.

Figure 5-2: Operating concept >values zoomed out

You can zoom out a measured value arbitrarily and place it somewhere in the
R&S NRPV window. The panes of these readings are transparent, so that the overlapping area remains visible.
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5.1.1.2

Sensor Info

Quick and convenient reading of information on the power sensor
●

Move the cursor on a sensor image in the status bar to get quick information on the
sensor type and its serial number, as shown in the figure below.

Figure 5-3: Operating concept > Status bar

●

Double-click the sensor icon to open an information window with detailed information to the sensor.

Figure 5-4: Operating concept > Sensor Info

You can readout or even copy this info, for example to have it at hand for service
purposes.

5.1.1.3

Print or Copy to Clipboard
Using the right mouse button, you can open a context-sensitive menu within each measurement window. Apart from the main functions, you can print out the current readings
or measurement curves, or store them in the clipboard, for example to copy the data to
an external program for further documentation
Print
Displays a print preview of the corresponding measurement result.
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Table 5-1: Printout examples

Trace measurement

Statistics measurement

Numerical measurement

Timeslot measurement

Copy to Clipboard
Creates a screenshot of the current result window and temporarily stores it on the clipboard. You can now insert this hardcopy in a document.
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Table 5-2: Printout examples

Trace measurement

Statistics measurement

Numerical measurement

Timeslot measurement

5.1.2 Application Window
This section describes the specific R&S NRPV window components. Besides the main
application window additional windows are opened according to the selected measurement.
In general the application distinguishes between "Graphical measurement mode" and
"Numerical measurement mode", represented in results windows. Results are displayed digitally and graphically. A results window contains several areas, for example a
display area, a control panel on the right, and, depending on the measuring mode, a
results table (measurement panel) which contains specific parameters. The numeric
measurement modes display the results digitally. In the graphic measurement mode
R&S NRPV displays the results graphically, including relevant information in the upper
range of the window. With the functions in the right panel you can configure the respective measurement window. A graphical measurement window also contains a table that
represents the values numerically.
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Menu bar
The menu bar provides the menus of the application.

Figure 5-5: Operating concept > Menu bar

Menu
A menu displays a list of functions, with some of them visualized by icons. Find an
overview of functions with associated icons in Chapter 5.1.5, "Icons, Toolbar and Shortcuts", on page 61.

Figure 5-6: Operating concept > Menu

Toolbar
Contains buttons and options to execute the functions. Most of the toolbars' functions
are also listed in a menu.

Figure 5-7: Operating concept > Toolbar

Status bar
The status bar displays the connected sensors, the channel they are assigned to (or
short name), and the current activity.
The background color of the sensor symbol represents the activity:
Indicates the active channel.
Indicates that the measurement in this channel is currently not active.

5.1.2.1

Numerical Measurement Window
Numerical measurement windows indicate the measurement results numerically. On
the right side a control panel provides buttons for accessing further dialogs, entry fields
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for measurement related settings, and the "Snapshot" button for storing current settings.

Figure 5-8: Operating concept > Numerical measurement window

5.1.2.2

Graphical Measurement Window
Graphical measurement windows, as for example in trace or timeslot mode, are divided into three sections:
●

the display area, containing the graph and a diagram description bar

●

the control panel on the right side with softkeys and entry fields

●

the measurements panel underneath the graph
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Figure 5-9: Operating concept > Numerical measurement window

Several parameters as grid, reference arrows, scale labels, trigger, marker and level
information are provided to configure the diagram, depending on the selected measurement mode. Refer to the respective descriptions to the results windows:

5.1.2.3

●

Chapter 6.4.2.2, "Graph in Trace Mode", on page 100

●

Chapter 6.4.3.2, "Graph in Statistics Mode", on page 127

●

Chapter 6.4.4.2, "Results in Numerical Mode", on page 140 and Chapter 6.4.4.3,
"Graph in Timeslot Mode", on page 141

Measurement panels

Figure 5-10: Operating concept > Measurement panels
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A measurement panel is arranged underneath the diagram. It consists of several tabs
which contain the significant parameters of the measurement. R&S NRPV displays the
current readings.
Convenient adjusting of the measurement panel size
The width of the panel is fixed. However, you can change the height of the measurement panel individually by dragging the frame accordingly.

5.1.3 Configuration Dialogs
This section describes the structure of the application dialogs. The dialogs are also
designed in window format, covering the same main elements, as e.g. entry fields,
check boxes or buttons. Some entry fields are partially structured in tabs. Each dialog
provides buttons to apply, confirm or cancel the entered settings.
The application mainly distinguishes between the measurement, math and display or
diagram configuration dialogs. Some measurement modes additionally contain sub
menus and dialogs for setting special parameters, as e.g. markers.
5.1.3.1

Measurement Configuration Dialogs
Table 5-3: Operating concept > Measurement configuration dialogs

Measurement configuration dialogs contain the entry fields for setting the parameters
of the currently selected measurement mode.
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5.1.3.2

Math Configuration Dialogs
Table 5-4: Operating concept > Math configuration dialogs

Math configuration dialogs contain math parameters and operands.
Depending on the selected measurement, the math configuration dialogs vary.

5.1.3.3

Display Configuration Dialogs

Figure 5-11: Operating concept > Display configuration dialog

A display dialog covers entry fields for configuring diagram parameters in numerical
measurement modes.
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5.1.3.4

Diagram Configuration Dialogs
Table 5-5: Operating concept > Diagram configuration dialog

A diagram dialog covers entry fields for configuring diagram parameters in graphical
measurement modes.
Depending on the selected measurement, the diagram configuration dialogs vary.

5.1.4 Menus
This section describes the menu structure of the application. Menus are designed in
window format and display a list of functions. Menus are opened with the aid of the
mouse or by using the [ALT+<key>] combination on the keyboard.
The following figure shows the available main menus of the application. For detailed
description of the several menu items refer to Chapter 6, "Settings - GUI Reference",
on page 69.
5.1.4.1

Main Menus and Submenus
The main menus are located in the menu bar at the top of the screen.

Figure 5-12: Operating concept > Menu bar
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A list item of a menu marked with an arrow, represents a general term and covers a
submenu.

Figure 5-13: Operating concept > Submenus

R&S NRPV contains the following menus:
File

Figure 5-14: Operating concept > File menu

Contains all functions that belong to task management. Create, save or recall measuring data or print the measuring results.
Configure

Figure 5-15: Operating concept > Configure menu
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Contains functions for setting the startup configuration, channel configuration and signal frequency. Additionally, the menu provides dialogs to specify basic parameters for
all measurement modes and dialogs for loading settings of digital standard communication signals.
Trigger

Figure 5-16: Operating concept > Trigger menu

This menu is used for setting the parameters of an external connected trigger source.
Measure

Figure 5-17: Operating concept > Measure menu

Menu for selecting the measurement mode.
Zero

Figure 5-18: Operating concept > Zero menu

Menu for zero error correction.
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Window

Figure 5-19: Operating concept > Window menu

A Windows menu contains functions for window handling.
Help

Figure 5-20: Operating concept > Help menu

The help menu with access to the online help and information about the R&S NRPV
software version.
5.1.4.2

Context-sensitive Menus
R&S NRPV provides special context-sensitive menus for each area of a measurement
window, with the exception of measurement panels. Open a context menu by pressing
the right mouse button.
A context-sensitive menu within the graphic range mainly contains the functions of the
control panel.
The following figure gives an example of context-sensitive menus.

Figure 5-21: Operating concept > Context-sensitive menus
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For detailed description of the available menus refer to
●

Chapter 6.4.2.4, "Context-sensitive Menu in Trace Mode", on page 101

●

Chapter 6.4.3.4, "Context-sensitive Menu in Statistics Mode", on page 128

●

Chapter 6.4.4.4, "Context-sensitive Menu for Numerical Measurement Modes",
on page 142

●

Chapter 6.4.4.5, "Context-sensitive Menu in Timeslot Mode", on page 143

5.1.5 Icons, Toolbar and Shortcuts

5.1.5.1

Toolbar
The toolbar of the main application window contains icons for quickly starting the main
functions.

Figure 5-22: Operating concept > Toolbar

Each icon features a corresponding item in the menu lists. For assignment on the icons
to the corresponding functions see Chapter 5.1.5.2, "Icons", on page 61.
5.1.5.2

Icons
To execute a task the application provides icons for main and frequently used functions.
► To start a measurement, perform one of the following:
●
●
●

Select the icon.
Select "Measure > Continuous" in the menu bar.
Press "F4".
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Figure 5-23: Operating concept > Icons

The following table lists the functions that can be started quickly by an icon, function
key or a specified keyboard sequence (shortcut):
Table 5-6: Icons and the corresponding functions
Icon

5.1.5.3

Function

Corresponding Menu item

Shortcut

New Task

File > New Task Starting With

-

Load Task

File > Open Task

CTRL+O

Save Task

File > Save Task

CTRL+S

Trace

Measure > Trace

F2

Statistics

Measure > Statistics

F3

Continuous

Measure > Continuous

F4

Gated

Measure > Gated

F5

Burst Average

Measure > Burst

F6

Timeslot

Measure > Timeslot

F7

Start Measurement

Measure > Start All

F10

Stop Measurement

Measure > Stop All

F11

Open data recorder

Measure > Data Recorder

F12

Trigger Settings

Trigger > Settings …

-

Channel Settings

Configure > Channel Settings …

-

Index

Help > Index

F1

Shortcuts
Shortcuts are a combination of keystrokes that provide quick access to commands,
functions or operations.
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Like the icons in the toolbar, the R&S NRPV has predefined key combinations that
invoke particular functions.

Figure 5-24: Operating concept > Shortcuts in menus

The following table lists the functions that can be started quickly by a shortcut:
Table 5-7: Shortcuts and the corresponding functions
Shortcut

Function

Corresponding Menu item

[ALT+C]

Cascade

"Window > Cascade"

[ALT+Left]

Active Previous

"Window > Active Previous"

[ALT+Right]

Active Next

"Window > Active Next"

[ALT+T]

Tile

"Window > Tile"

[CTRL+A]

Channel Assignment

"Configure > Channel Assignment"

[CTRL+B]

Burst Average

"Configure > Burst Average"

[CTRL+C]

Continuous

"Configure > Continuous Average"

[CTRL+G]

Gates

"Configure > Gates"

[CTRL+I]

Statistics

"Configure > Statistics"

[CTRL+O]

Open Task

"File > Open Task"

[CTRL+S]

Save Task

"File > Save Task"

[CTRL+T]

Timeslots

"Configure > Timeslots"

[CTRL+U]

Pulse Measurement

"Configure > Pulse Measurement"

[CTRL+X]

Exit

"File > Exit"

[CTRL+Z]

All Channels

"Zero > All Channels"
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5.1.6 Diagrams
Several parameters as grid, reference arrows, scale labels, trigger, marker and level
information are provided to configure the diagram, depending on the selected measurement mode. Refer to the respective descriptions to the graphs:

5.1.6.1

●

Chapter 6.4.2.2, "Graph in Trace Mode", on page 100

●

Chapter 6.4.3.2, "Graph in Statistics Mode", on page 127

●

Chapter 6.4.4.2, "Results in Numerical Mode", on page 140 and Chapter 6.4.4.3,
"Graph in Timeslot Mode", on page 141

Info and Symbols
According to channel, measurement and math operation the diagram description bar,
or the result fields in numerical measuring modes may contain various information,
some shown as symbols. The indicated parameters, and values and symbols, representing, for example, measurement mode, numeric and auxiliary values, trigger,
marker or filter values or even warnings are activated for display in the respective configuration dialogs of the measurement. They are each identified by their assigned colors, i.e. the color of a value in a description box corresponds to the color of the measurement and the graph.
Refer to the following table to get an overview on some individual symbols:
Table 5-8: Special symbols
Icon

Function
Duty cycle correction active

Offset correction active

S-Parameter correction active

Trigger on rising slope

Trigger on falling slope

Waiting for trigger event

Info
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Icon

Function
Error occurred

Warning for example out of range

5.2 Operating
R&S NRPV operating is similar to the operation of the Microsoft®Windows user interface. All menus and dialogs are in the form of windows and can be operated in the
same way. Mouse or, in some cases alternatively keys allow direct access to entries
and settings. Selected items are blue highlighted, a yellow frame indicates that a
selected button or tab is active.

5.2.1 Enter and Confirm Settings
Enter values, units and text by activating the entry field with the mouse and then use
the keyboard.
Numerous help functions, called by [F1] function key support the user in measurement
configuration.
Apply
Apply the settings to the current measurement without closing the active window.
Ok
Apply the settings and close the active window
Cancel
Aborts the active window without applying the settings or saving the changes.

5.2.2 Elements
All menus, dialogs and diagrams are made up of known elements, e.g.
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Table 5-9: GUI Elements
User interface element

Description
Menu items
In a menu a selection can be made from a list. The
selection list folds down by clicking the menu name.

Dialog header
The header line contains the name of the menu and
a button closing the menu. The button can be operated with the mouse.
Dialog area
Several fields of associated but separately set
parameters are organized in an area.
The dialog areas are separated from each other with
a frame.
Tab
Settings fields structured in separate tabs within a
dialog.

Selection field
The button indicates that a selection can be made
from a list. The fold-down selection list is displayed
below the selection field.
One entry at a time can be selected from the list. If
an item is not available for selection, it is grayed out
and cannot be accessed.
Check box
If the check box is ticked, the associated parameter
setting is active (switched on).
Tool tip
Help function indicating an explanation to the currently selected element.
Numerical entry field
A numeric value can be entered.
Alphanumerical entry field
An alphanumeric value can be entered.
Color selection field
Opens a dialog for selecting a color.
Buttons
A button either triggers a single action or calls the
next menu.
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User interface element

Description
Selecting field
Area for selecting the channel and the sensor,
respectively.

Status field
Indicates the state of either the currently running
task or the state of a connected sensor.
Scroll bars
When a window cannot be shown completely then
the window will get scroll arrows on the right side
and bottom for scrolling.

Hide/Show control in the splitter bar
Shows / hides a control panel or measurement
panel by mouse click on the striped bar.

5.2.3 Mouse Operation
Basically the mouse as pointing device is similar to every computing system. This section only touches information on some special features of the application.
Clicking the right mouse button performs context-sensitive menus for the following controls:
●

Channel traces

●

Math traces

●

Marker symbols

●

Limit lines

●

Trigger levels and symbols

●

Vertical reference position symbol

●

Residual screen area

●

Trace window

5.2.4 Splitter bar
The control and measurement panels are separated from the diagram by splitter bars.
Each splitter bar contains a button to hide or show each panel.

Figure 5-25: Operating concept > Splitter bar
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The width of the control panel is fixed, whereas the height of the measurement panel is
flexible. Therefore the space between the diagram and the measurement table can be
shared by moving the splitter bar with the mouse.

5.3 Data Management
R&S NRPV provides basic measurement settings, which are already stored in the
application. It also supports saving user-defined settings and measurement data. Usually drive C:\ is intended to save user-defined data, but you can also select any directory structure. Some default directories are predefined, as for example TaskFiles
that is recommended by the application. The filenames and directories are user-selectable and can be changed.
The user data is divided into the following data types:
●

Signal template
This file contains samples with basic measurement parameters predefined in the
application. See Chapter 6.2.14, "Load Template", on page 90 to call predefined
settings.
Note: Templates refer to the default application settings and cannot be changed.

●

Tasks
Task files contain settings of a measurement. See Chapter 6.1, "File Menu",
on page 69 for handling with task files. For tasks files the directory
%APPDATA%\Rohde-Schwarz\NRPV\TaskFiles\*.tsk is selected by default.
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6 Settings - GUI Reference
"Settings" describes all dialogs and functions of the application in detail.

6.1 File Menu

Figure 6-1: File menu > New Task Starting With...

The "File" menu contains all functions that belong to file management, like creating,
saving or recalling measurement data or printing the measurement results.
Task files are stored in the default directory
%APPDATA%\Rohde-Schwarz\NRPV\Taskfile\<taskname.tsk>.
In addition, the R&S NRPV application can be closed with the "Exit" function.
New Task Starting With...
Opens the sub menu for selecting a measurement task.
Trace Window ← New Task Starting With...
Creates a task for measurement mode Chapter 6.4.3, "Statistics", on page 125.
Statistics Window ← New Task Starting With...
Creates a task for measurement mode Chapter 6.4.3, "Statistics", on page 125.
Continuous, Gated, Burst Average or Timeslot Window ← New Task Starting
With...
Creates a task for a numerical measurement mode.
The measurement windows of these modes are almost similar. The description in
Chapter 6.4.4, "Numerical", on page 138 applies to all modes. Special features are
described explicitly.
Open, Close, Save, Save As Tasks
Manages task files.
These functions are self-explanatory and similar to the Microsoft®Windows file dialog.
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Note: The extension of a measurement task is *.tsk and cannot be changed. By
default, the file storage location is
%APPDATA%\Rohde-Schwarz\NRPV\Taskfile\<taskname.tsk>
Licensing
Opens the "Licensing NRP-Z Power Sensors for NRPV" dialog.
In this dialog, you can enable an R&S NRP-Zxx Power Sensors for use with
R&S NRPV, see Chapter 3.6, "Activate an R&S NRP-Zxx Power Sensors in
R&S NRPV", on page 18. Note: All members of the R&S NRPxxS[N], NRPxxT[N] and
NRPxxA[N] power sensor families are by default enabled for the use with R&S NRPV.
Recent Task Files
Lists the recently used task files. Select a task to reopen it.
Exit
Closes the application.
R&S NRPV requires a prompt for storing modified tasks, to save the last changes in
the task file.

6.2 Configure

Figure 6-2: Configure menu

The "Configure" menu contains functions for setting the startup configuration and functions to configure channel assignment, channel settings and signal frequency settings.
Also, the menu provides dialogs to specify the use of VISA communication-based sensors and basic parameters for all measurement modes, and defined R&S values and
settings of digital standard communication signals.
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6.2.1 Functions
Startup Configuration
Opens the dialog for specifying the settings used at the start of R&S NRPV. Chapter 6.2.2, "Startup Configuration", on page 73. You can select between user-defined
settings (from a specified task file), settings of the last measurement, or by application
defined default settings.
VISA Sensor Configuration
Opens the dialog for managing all power sensors which use VISA communication
channels like USBTMC or VXI-11. See Chapter 6.2.3, "VISA Sensor Configuration",
on page 73.
Note:
● This dialog is only available if a VISA driver is installed on the host PC.
● This dialog is related to the R&S NRPxxS[N], NRPxxT[N] and NRPxxA[N] power
sensor families. The members of the traditional R&S NRP-Zxx power sensor series
cannot be selected here.
You can trigger a search for locally connected (VISA capable) USB power sensors
which are then automatically taken over into the sensor list. Furthermore you can manually add any number of network sensor resources.

Color Settings
Accesses the dialog for setting the colors, see Chapter 6.2.4, "Color Settings",
on page 74. In this dialog you can design your measurement windows, i.e. you can
arbitrarily assign colors to the traces, curves and markers, and to background and grid
lines of diagrams.
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Channel Assignment
Opens the dialog for selecting and assigning the channel, see Chapter 6.2.5, "Channel
Assignment", on page 75. This dialog covers information on the connected power
sensors and its connectivity.
Signal Frequency
Opens the "Signal Frequency" dialog for setting the carrier frequencies of the signals,
see Chapter 6.2.7, "Signal Frequency", on page 82.
Channel Settings
Opens the dialog for configuring a channel, see Chapter 6.2.6, "Channel Settings",
on page 76. Channel settings include offset, video bandwidth, gamma and S-Parameter correction, ranging, and averaging.
Measurement Modes
The following topics provide dialogs to configure basic signal parameters that are independent of the used power sensor. These parameters represent the global settings and
are needed in principle with the respective measuring modes. Changes of these settings are saved in task files.
Note: See also Chapter 6.2.14, "Load Template", on page 90 to recall predefined
settings based on a measurement mode or based on a digital standard communication
signal.

Figure 6-3: Configure menu > load template

Continuous...
Continuous opens the dialog for configuring the measurement window settings as
aperture time, sampling frequency and smoothing.
Note: For trace and statistics measurement mode, signal frequency is displayed in the
Chapter 6.4.2.3, "Diagram Description Bar", on page 101.
Burst Average...
The Burst Average contains excluding times and dropout.
Statistics...
Opens the Statistics for setting the aperture time.
Timeslots...
Opens the dialog Timeslots for configuring timeslot and fence parameters.
Gates...
Gates opens the dialog for configuring gate and fence parameters.
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Pulse Measurement...
Selects the algorithm for evaluating pulse signals and set the threshold parameters in
the dialog Pulse Measurement.
Load Template...
Opens the dialog Load Template for loading predefined settings of or CW signals, or
digital standard communication signals like GSM.

6.2.2 Startup Configuration
This function enables you to determine the initial configuration of R&S NRPV at
startup.

Figure 6-4: Configure > Startup Configuration dialog

NRPV Configuration for Startup
Opens the dialog for selecting how the R&S NRPV starts.
"Last Active Settings"
Starts in the same mode, which was active during the last measurement.
"User Defined Settings"
Starts in a user-defined mode, which was previously specified and
saved in a task file.
"Default Settings"
Starts with preset values.

6.2.3 VISA Sensor Configuration
In this dialog, you can define any number of VISA sensors by adding the VISA
resource name. The sensors do not have to be connected while defining them here.
From the list of possible sensors, you can select which ones are to be used later in
R&S NRPV measurement windows by activating the checkbox in the "Use" column.
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The dialog provides also functions to edit a selected VISA resource name or for removing entries from the defined list. You can double-click a resource name to edit it. Furthermore you can easily add all currently connected USB sensors to the list clicking the
"Find USB Sensors" button.
When you close the dialog with "OK", the configuration dialog tries to find and open all
sensors which have been selected for measurements through an activated checkbox in
the "Use" column. All sensors which can be reached via the defined VISA communication channel are added to the program's internal list of available sensors. The available sensors can then be assigned to measurement windows in the corresponding measurement dialogs. Sensors which are marked here with the "Use" flag but are not available physically, are ignored.

6.2.4 Color Settings
In this dialog, you can individually assign colors to traces and curves, including the
associated markers, and to background and grid lines of diagrams.
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Figure 6-5: Configure > Color Settings dialog

In "Color Settings" select individual colors for your measurements, or set all colors to
default
Color Settings...
Opens a dialog to set the colors.

6.2.5 Channel Assignment
The "Channel Assignment" dialog displays all connected sensors with information on
the sensor type, serial number and connectivity.
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Figure 6-6: Configure > Channel Assignment dialog

Note: With one power sensor connected, the R&S NRPV program automatically
assigns the power sensor to channel A.
Channel Name
Lists the connected channels.

Figure 6-7: Configure > Channel assignment > rename

The R&S NRPV detects all connected sensors automatically and applies capitals to
each channel in alphabetical order.
You can assign a short name to a channel. The maximum length is three characters in
capital letters, as for example "IN" or "OUT".
Sensor Type, Serial Number & Connectivity
Displays information on the connected sensors.
"Current"

Displays information on the currently connected sensor.

"Previous"

Displays information on the previously connected sensor.

6.2.6 Channel Settings
The "Channel Settings" dialog covers entry fields for setting sensor related channel
parameters.
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Figure 6-8: Configure > Channel settings dialog

The dialog contains sensor related parameters.
The parameters are grouped by functionality, such as "Offset", "Video bandwidth", "SParameter" and "Gamma" correction, "Ranging" and "Averaging". If a sensor does not
support a certain functionality, the corresponding controls are disabled.
Channel
Selects the channel.
Offset
Note: If the signal level is higher than the permissible input level of the sensor, it is recommended that you connect an attenuator between the signal source and the sensor.
The attenuator prevents the sensor from damage due to high input power. The offset
correction compensates the difference between the real signal level and the level at
the sensor input. The indicated value corresponds to the real signal level.
Enter and activate correction factors to increase or decrease the measurement result
value. Correct only factors, which do not, or only minimally depend on frequency or
level. For example, use this function to adjust attenuators, directional couplers or
amplifiers that are connected between the signal source and the sensor.
Positive offset values correspond to external losses, negative values to external gains.
The symbol indicates that offset correction is active.
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Global ← Offset
Activates the offset correction globally for all frequencies with the entered value.
0.000 ← Offset
Sets the global offset value. That means, the offset for all frequencies.
R&S NRPV automatically adjusts the trigger level when the offset correction values
vary. A prompt requires the adjustment to be confirmed.

Figure 6-9: Configure > Channel settings > automatic trigger level update

File ← Offset
Selects a file with offset correction data.
A file contains a table with frequency/offset pairs.
The extension of a correction file is *.s1p, or *.txt. If there is an *.s1p, the file content must conform with the touchstone file specification, see http://en.wikipedia.org/
wiki/Touchstone_file. The correction files are stored in the application data directory
%APPDATA%\Rohde-Schwarz\NRPV\<*.s1p>.
Video Bandwidth
Sets the video filter bandwidth
This parameter is supported by NRP-Z8x wideband power sensors.
You can use this value to reduce the video bandwidth in trace and statistics measurement modes. As a result, the trigger sensitivity is increased and the display noise
reduced. In order not to distort the signal, the video bandwidth must be smaller than
the RF bandwidth of the measurement signal.
A limited video bandwidth also reduces the sampling rate. Therefore, in trace mode,
the effective time resolution is reduced accordingly. In statistics mode, the measurement time must be increased appropriately to keep the required sample size. The following table shows the video bandwidth and the resulting sampling rate and sampling
interval by the example of an NRP-Z81 power sensor.
Table 6-1: Video bandwidth and sampling rate
Video Bandwidth

Sampling rate

Sampling interval

FULL

8 x 107 s-1

12.5 ns

5 MHz

4 x 107 s-1

25 ns

1.5 MHz

1 x 107 s-1

100 ns

300 kHz

2.5 x 107 s-1

100 ns
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"FULL"

For frequencies from 500 MHz on, FULL corresponds to a video
bandwidth of at least 30 MHz. For frequencies below 500 MHz, the
video bandwidth is automatically reduced to approx. 7.5 MHz.

"x MHz"

The video bandwidth is set to the selected value.

S-Parameter Correction
Selects and applies a data set of S-Parameters (available only for sensors that support
S-parameter correction).

Figure 6-10: Configure > Channel settings > S-parameter

In the Info line of the measurement window, the symbol
correction has been activated.

indicates that S-Parameter

S-Parameters are used to correct measurement results that are influenced by a twoport connection. If a complete set of S-Parameters is available in the R&S power sensor, the measurement can be corrected by way of calculation.
Note that a reference impedance of 50 Ohms must be used for the S-Parameters.
For information on how to use the S-Parameters table refer to the operating manual of
your NRP-Z8x power sensor.
Gamma Correction
Increases the measurement accuracy by either setting the magnitude and phase of the
source's reflection coefficient, or alternatively, the real and imaginary source.
The gamma correction value sets the complex reflection coefficient of the source. A
magnitude value of 0 is equivalent to an ideally matched source, and 1 corresponds to
total reflection. The phase angle can be set between -360.0 degrees and +360.0
degrees.
Apply ← Gamma Correction
Save gamma correction settings.
Single Frequency ← Gamma Correction
Activate/deactivate gamma correction with the set values.
Re. source ← Gamma Correction
Set the real part, i.e. the magnitude of the source reflection coefficient.
Im. source ← Re. source ← Gamma Correction
Set the imaginary part, i.e. the phase of the source reflection coefficient.
Magn. source ← Gamma Correction
Set the magnitude of the source reflection coefficient directly.
Phase source ← Magn. source ← Gamma Correction
Set the phase of the source reflection coefficient directly.
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File ← Gamma Correction
Select the file with gamma correction data and activate the gamma correction with data
from that file.
A file contains a table with magnitude/phase pairs. The extension of a correction file is
*.s1p or *.txt. By default correction files are stored in application data directory.
Ranging
Select the measurement path for multipath power sensors (NRPxxS(N), NRP-Z11,
NRP-Z21/22/23/24/28/31/41/61 and NRP-Z91/98 multipath power sensors only).
Multipath power sensors are equipped with several paths, providing different sensitivities and therefore different measurement ranges. The measurement paths are simultaneously active.
Auto ← Ranging
Activate automatic selection of the suitable path, that means paths that are not overdriven or underdriven. The measurement result of two partially overlapping measurement paths is derived from the measured values of both paths.
For some applications, e.g. test signals with a large peak-to-average ratio, measuring
with "Auto Ranging" does not lead to accurate measurement results. Use the crossover function, which lowers the level in the crossover, to prevent an overdriven measurement path from distorting the evaluation.
Transition Offset ← Ranging
Reduce crossover range. To prevent measurement paths which have been overdriven
by signal peaks from being included in the evaluation, levels can be reduced in the
measurement path crossover.
0.000 dB ← Ranging
Enter a negative crossover value as a measure for reducing the crossover levels. For
example, setting the level to -6 dB, the crossover is reduced by 6 dB. Drive range
increases of the same magnitude, which reduces measurement deviations due to modulation to 25% of the original value.
Note: While large signal characteristics improve as the crossover level drops, the
effects of zero deviations and intrinsic noise on the result increase, caused by the less
sensitive measurement path being underdriven. Therefore changing the crossover
level by more than 10 dB can deteriorate the measurement result.
Manual ← Ranging
Activate manual selection of the measurement range. One out of three paths can be
selected as measurement range, for example to the drive range of a path.
Crossover ← Ranging
Reduce crossover range.
To prevent measurement paths which have been overdriven by signal peaks from
being included in the evaluation, levels can be reduced in the measurement path
crossover.
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For example, if setting the level to -6 dB, the crossover is reduced by 6 dB. The drive
range increases by the same magnitude, which reduces measurement deviations due
to modulation by 25% of the original value.
While large signal characteristics improve as the crossover level drops, the effects of
zero deviations and intrinsic noise on the result increase. It is caused by the less sensitive measurement path being underdriven. Therefore, changing the crossover level by
more than 10 dB can deteriorate the measurement result.
path n ← Ranging
Define one of three paths as the measurement range, e.g. for testing the drive range of
a path.
Note: The Transition Offset entry disables manual functionality and vice versa.
Automatic Averaging
Use an averaging filter to reduce fluctuations in the measurement result. Either choose
automatic mode or set the averaging factor to a fixed value manually.
Note: Check if the auto filter mode is giving satisfactory results. If the power is not constant, adjust a manual optimal filter length setting always manually.
"Continuous "

Activate continuous mode.
This mode finds a balance between measurement time and display
noise.

"Fixed Noise "

Activate fixed noise mode.
Choose an averaging factor that the sensors intrinsic noise (2 standard deviations) does not exceed the specified "Noise Content". Having low power, limit the averaging factor by the duration of the "Max.
Settling Time" to avoid long settling times. In the "Info" line of the
measurement window, S/N indicates when the display noise exceeds
the preset value.
Note: Automatic averaging mode "Continuous" disables "Fixed
Noise" mode and vice versa.

Noise Content ← Automatic Averaging
Select the portion of intrinsic noise in the measured result. Specifically, this value gives
the permitted relative variation of the result which cannot be exceeded for 95% of the
observation time.
Max. Settl. Time ← Automatic Averaging
Enter time value and unit to specify the upper limit for the settling time. If the limit is
exceeded, S/N is displayed in the measurement window.
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6.2.7 Signal Frequency

Figure 6-11: Configure > Signal frequency dialog

Open the Chapter 6.2.7, "Signal Frequency", on page 82 for setting the carrier frequencies of applied signals. The following topics provide dialogs to specify basic signal
parameters that are independent of the sensor type. These parameters represent the
global settings and are needed in principle with the respective measuring modes.
Changes of these settings are saved in task files.
See also Chapter 6.4.2.3, "Diagram Description Bar", on page 101 to call up predefined settings based on a measurement mode or based on a digital standard communication signal.
Common Frequency
Apply the entered frequency value to all channels.
Channel
Select a channel.
Frequency
Enter the frequency value and unit of the signal applied to the selected channel.
Valid for all channels: disables single frequency settings and vice versa.
Note: For trace and statistics mode, signal frequency is displayed in the Chapter 6.4.2.3, "Diagram Description Bar", on page 101.
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6.2.8 Continuous

Figure 6-12: Configure > Continuous

Continuous opens the dialog for configuring the measurement window settings as
aperture time, sampling frequency and smoothing.
For trace and statistics measurement mode, signal frequency is displayed in the Chapter 6.4.2.3, "Diagram Description Bar", on page 101.
Channel
Select a channel.
Aperture
Width of the sampling window. Defines the length of the unsynchronized time interval
used to measure the average signal power.
●
●

●
●
●

For an unmodulated signal, the default setting of 10µs in conjunction with chopper
stabilization provides optimum noise suppression.
Wider sampling windows are required when the measurement result exhibits fluctuations due to modulation. With low frequency modulation in particular, a display
with optimum stability is provided by setting the sampling window length exactly
equal to the modulation period.
If the modulation period varies or is not exactly known, smoothing should also be
activated. Approximately five periods within one sampling window are sufficient.
The overall window length is calculated from the sampling frequency and the number of samples. The number of samples determines the length of the evaluation
window.
In addition, this parameter sets the length of the unsynchronized time interval for
statistical analysis of the signal, see Chapter 6.2.10, "Statistics", on page 85.

Sampling frequency
Defines the number of samples taken over the duration of a measurement window. The
sampling frequency is defined in Hertz.
●

If a sensor contains a sampling A/D converter, the sampling rate can be adjusted to
prevent aliasing effects for particular types of modulation signal. Aliasing can occur
with some sensors because the sampling frequency is located within the video
bandwidth, which means that spectral components of the modulation signal can fall
in this frequency range. When you change the sampling frequency, the aliasing
effects disappear.
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Smoothing
Enables a smoothing filter. The filter reduces result fluctuations caused by modulation,
if the aperture time cannot be exactly adjusted to the modulation period.
●

Smoothing creates an approximating function to capture important trends in repeat.
Relatively slow changes of value result in a close matching of curve fitting.

6.2.9 Burst Average

Figure 6-13: Configure > Burst average

The Burst Average dialog, contains excluding times from start/ end and dropout.
Channel
Select a channel.
Exclude from start
Defines the time gap to be excluded from measurement at the beginning of the burst.
Exclude from end
Defines the time gap to be excluded from measurement at the end of the burst.
Dropout
Define the end of the burst by setting a dropout time in microseconds. Modulation-specific power drops that are shorter than the set value are ignored.
Note: During the dropout time, unwanted trigger signals are rejected.
The set dropout time only affects the internal trigger source.
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6.2.10 Statistics

Figure 6-14: Configure > Statistics

Open the Statistics dialog, for setting the aperture time.
Channel
Select a channel.
Aperture
Width of the sampling window. Defines the length of the unsynchronized time interval
for statistical analysis of the signal.

6.2.11 Timeslots

Figure 6-15: Configure > Timeslots

Opens the dialog Timeslots for configuring timeslot and fence parameters.
Number of timeslots
Defines the number of subsequent timeslots that belong to one single frame.
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Timeslot
Contains the parameters to configure the time slot.
Nominal width ← Timeslot
Defines the timeslot length by setting time value and unit.
Note: For TDMA signals the nominal timeslot length must be entered here, i.e. the
frame length is divided by the number of timeslots.
Exclude from start ← Timeslot
Defines the time gap to be excluded from measurement at the beginning of the timeslot. Enter time value and unit.
Exclude from end ← Timeslot
Sets time value and unit for the time gap to be excluded from measurement at the end
of the timeslot.
Note: Exclude
You can also interactively set "Exclude from Start" and "Exclude from End" interactively
in the scope display in the timeslot measurement window.
Load
For various common mobile radio standards, you can load the specified parameters
under Chapter 6.2.14, "Load Template", on page 90.
The timeslots can be set interactively in trace measurement mode.
Fence
Contains the parameters to configure the fence.
Active ← Fence
Activate the fence function. Fence is a time interval within the measurement period to
be excluded from measurement.
Start of fence ← Fence
Set the start of fence referring to the timeslot and its length. Enter time value and unit.
Length of fence ← Fence
Define time value and unit for the length of period to be excluded from measurement.
Locked ← Fence
Block the entry fields. Defines if the timeslot parameters are editable directly or graphically. Protect the settings against accidental changes.
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6.2.12 Gates

Figure 6-16: Configure > Gates

Gates opens the dialog for configuring gate and fence parameters.
Gates
Select a gate. Up to four different gates can be configured. Measurement is performed
only in one gate at a time.
Gate
Contains the parameters to configure the gate.
Start ← Gate
Set the start time of the selected gate. Enter time value and unit.
Length ← Gate
Define the length of gate for measurement, by setting time value and unit.
Active ← Gate
Activate fence function. Fence is a time interval within the measurement period to be
excluded from measurement.
Start ← Gate
Define the start of gate fence to exclude from measurement. Enter time value and unit.
Length ← Gate
Define time value and unit for the length of period to be excluded from measurement.
Locked
Block the entry fields. Define if the gate parameters are editable directly or by graphical
means. Protect the settings against being changed by mistake.
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6.2.13 Pulse Measurement

Figure 6-17: Configure > Pulse measurement

Select the algorithm for evaluating pulse signals and set the threshold parameters in
the dialog Pulse Measurement.
Pulse data NRP-Z analysis
R&S NRPV supports pulse data analysis in cooperation with a power sensors NRPZ81, NRP-Z85 or NRP-Z86 which are working in time measuring mode.
Power sensors NRP-Z81, NRP-Z85 or NRP-Z86 enable pulse data analysis in measurement mode time. All important pulse parameters are measured after setting the
threshold levels. The following graph shows most of these parameters:
Rise Time

Fall Time

Top Power
Distal Power

Pulse Period
Pulse Width

Pulse Off Time

Proximal Power
Base Power
Pule Start Time

Pules Stop Time

Figure 6-18: Pulse data analysis diagram
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The sensor calculates the pulse parameters from each measurement and delivers the
results to R&S NRPV.
Algorithm

Select the analysis algorithm for detecting the pulse top and the pulse base power of a
pulsed signal. These two power levels are fundamental for all further signal analysis.
Note: NRP-Z81/Z85/Z86 power sensors provide pulse data analysis.
"Histogram"

Computes the pulse levels by analyzing the histogram of the trace
data.
By evaluating the probability density of the values of one recorded
trace, histogram defines the pulse top and pulse base power level due to fact that these bars contain the maximum number of hits in
upper and lower half of the histogram. If the signal has too much
noise that there is no maximum bar, the algorithm returns the min and
max peak sample values as base level and top level.
Note: This algorithm is recommended for analyzing most of the pulse
signals.

"Integration"

Detects the pulse top power by fitting a reference rectangle pulse into
the pulse signal. The algorithm approximates the signal by an ideal
signal with the same energy content, pulse duration and pulse period
by calculating the integral of the pulse power and the corresponding
voltages.
Note: Use these algorithms for pulse signals with fast rise- and falltimes and pulses with amplitude variations, e.g. modulated signals.
I.e. use the integration algorithm if the energy content of the complete
pulse, including rising and falling edges, is needed and not only the
most probable top level.

Auto Equivalent-Time Sampling
Activate auto equivalent sampling.
Thresholds
The threshold parameters Distal, Mesial and Proximal define the high, mid and low reference level that are used to determine the pulse timing. All values are specified in percent of the pulse amplitude, i.e. the difference between top and base power. Levels are
related to power readings in [Watt].
Voltage/Power related ← Thresholds
Select how the threshold parameters are calculated, either voltage related or power
related. The voltage-related parameters represent the normal case, as the usual representation when defining the pulse parameters (rise/fall time, pulse width) is U(t). To
achieve a display with equivalent power-related values, the voltage-related threshold
values must be converted (squared).
The following table compares levels related to Volts, [Watt] and dBW.
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Table 6-2: Voltage / power-related reference level
Reference level

Voltage-related(%V)

Power-related (%W)

Log. scale (dB)

Distal

90

81

-0.9

Mesial

50

25

-6

Proximal

10

1

-20

High Ref Level (Distal) ← Thresholds
Set the high reference level in terms of percentage of the overall pulse level. The distal
power defines the end of the rising edge and the start of the falling edge of the pulse.
Mid Ref Level (Mesial) ← Thresholds
Set the medial reference level in terms of percentage of the overall pulse level. This
level is used to define the pulse width (τ) and pulse period.
Low Ref Level (Proximal) ← Thresholds
Set the low reference level in terms of percentage of the overall pulse level.
The proximal power defines the start of the rising edge and the end of the falling edge
of the pulse.

6.2.14 Load Template

Figure 6-19: Configure > Load template

Open the dialog Load Template for loading predefined settings of digital standard communication signals as GSM or CW.
Communication and standards

Figure 6-20: Configure > Load template > Select standard
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Currently the program provides the settings of several communication standards, plus
a CW (continuous wave) signal with set frequency and level.
"--Default–"

Default values.

"<standard>"

Selects the preferred from standard communication signal.

"CW"

Settings from the stored CW signal.

Preserve window settings
Determine whether the window settings are to be reconfigured.
"OFF"

Use the window parameters from the template to optimize the diagram.

"ON"

Use already determined parameters.

Preserve trigger settings
Determine whether trigger settings are to be reconfigured.
"OFF"

Use the already optimized trigger parameters from the template.

"ON"

Use the individually determined trigger parameters.

Activate Selected Communication Standard
Assumes the settings of the selected standard.

6.3 Trigger

Figure 6-21: Trigger menu

Trigger signals are used to configure the timing conditions for the start of a measurement. The trigger system is required for the average measurement modes timeslot,
gate and burst, as well as for trace and statistics.
The Trigger menu contains the items Settings..., used for opening a dialog to configure trigger parameters, and MASTER-Trigger & SYNC, covering a submenu for
selecting a device intended for synchronizing trigger signals of several devices or triggering a service request.
Settings
Settings opens the trigger configuration dialog to apply a trigger source and to set the
appropriate parameters.
Master
MASTER-Trigger & SYNC Configuration opens the dialog to set the trigger master/
slave and configure the synchronization.
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6.3.1 Settings
The trigger settings dialog contains all trigger functions.

Figure 6-22: Trigger settings dialog

Channel
Select the channel.
Trigger source
Activate the trigger source.
Internal

Select internal trigger source. The trigger event is generated by the sensor.

External

Select external trigger source. The trigger event is executed with the aid of the
active edge of the sensor's incoming trigger signal. The active edge is selected
under Slope.

Trigger slope
Activate the trigger slope.
"Positive"

Set the rising edge of the trigger signal as active slope. The
R&S NRPV shows the symbol in the display.

"Negative"

Set the falling edge of the signal as active slope, indicated by

.

Trigger level
Determine the high/low threshold a trigger signal must exceed or fall short before a
trigger event is detected.
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"Manual"

Enter the power value of the high / low threshold in dBm. For a positive slope, the measurement is triggered when the signal level rises
above the threshold. The threshold determines the power level, at
which the signal is high (active) or low (inactive). In case a negative
slope is set, the trigger event is initiated when the signal level falls
below the threshold.
Tip: Defining the trigger level manually.
Setting the trigger level manually is only possible for internal trigger
sources. The setting is irrelevant to all other trigger sources. To achieve stable trigger conditions, a trigger level above -20 dBm is advisable. If an S-Parameter device has been activated, the trigger level
setting is always referenced to the input of this device. When switching the S-Parameter device on or off, the set trigger level and the
entry limits are automatically adjusted.

"Auto"

Enable triggering automatically.
Note: Trigger level Auto disables editing manually and vice versa.
Tip: Automatically triggered internal source
In the Trace mode, Auto activates the automatic setting of the trigger
threshold for internal triggering. The smallest and the largest sample
values within the trace length are determined. The trigger threshold is
then set exactly to the midpoint of these two values.
If no trigger events are initiated for more than 0.3 seconds, an automatic search phase lasting 1 second is activated and then the trigger
threshold is reset.

Trigger delay
Enter the delay value and unit. Setting a positive value delays the effect of the trigger
event until the set time has elapsed. Entering negative values provides pretriggering,
which is, depending on the sensor type, limited to a few ms.
Dropout
Set the dropout time in seconds. Enter value and the corresponding unit.
This parameter prevents the trigger system from being activated too early if the signal
briefly falls below or exceeds the trigger threshold. The parameter is set to a value that
is slightly higher than the maximum duration of power fluctuations that are not supposed to execute triggering.
Hysteresis
Set a hysteresis value of the internal threshold. Use this function to eliminate the noise
effects on the edge detector of the trigger system.
Hysteresis is a magnitude added to the threshold. The signal level must pass the sum
of threshold and hysteresis before the next trigger event can be initiated. Trigger hysteresis prevents the trigger system from being activated too fast while the trigger threshold is slightly fallen short or exceeded. With hysteresis, a trigger event is only initiated if
the signal level drops down the trigger level minus hysteresis for positive slopes. For
negative slopes, the level must be higher than the trigger level plus hysteresis value.
Note: Trigger hysteresis setting only applies to the internal trigger source.
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Hold off
Set a time value in seconds. Hold off suppresses trigger events within the set hold off
time, starting from the last successful triggering. Use this function to exclude unwanted
trigger events.
Locked
Block the entry fields. Determine if the trigger parameters are editable directly or protect the settings against being changed by mistake.

6.3.2 MASTER-Trigger & SYNC Configuration

Figure 6-23: MASTER-Trigger & SYNC dialog

The "MASTER-Trigger & SYNC" dialog contains the settings necessary for configuring
a trigger master and setting the synchronization of the sensors.
MASTER
Selects one of the available sensors as the trigger master.
The Rohde & Schwarz USB power sensors can be operated in a master/slave trigger
configuration. Such a configuration enables you to select one of the available sensors
to be the trigger master.
The sensor which is configured as the trigger master outputs a digital trigger signal in
sync with its own trigger event. This makes it possible to synchronize several sensors
(see also SYNC) and to perform measurements in sync with a signal at very low
power, which normally would not allow signal triggering. The trigger signal which is output has a length of 10µs and the positive slope coincides with the physical trigger point.
This way other sensors which are connected to the trigger line and are configured for
external trigger will start their measurement(s) in sync with the trigger event of the
master.
In case of the traditional R&S NRP-Zxx power sensor series there is only one external
trigger line. Hence the master trigger signal can only be emitted via that connection.
The newer R&S NRPxxS(N) series are equipped with two external trigger lines. Therefore there is an additional selection for where the master trigger signal shall be emitted
("External 1" or "External 2").
SYNC
Selects whether a sensor shall take part in trigger synchronization.
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In order to avoid spurious triggers in an interconnection of various sensors the trigger
synchronization can be used. For a better understanding you should know that the trigger system (by means of external trigger connections) is controlled by edges, not levels. A trigger event is characterized by a positive edge on the trigger line. As a consequence of this a (new) trigger event cannot be produced while the level of the trigger
line keeps high. And exactly this is the purpose of the trigger sync mechanism.
When the trigger sync function is activated in a sensor, the device holds its trigger line
high while it is executing/processing the current measurement. As soon as the sensor
becomes ready it releases the trigger line. Since the (externally interconnected) digital
trigger line acts as a wired-or logic, the level on the trigger line stays high until the
slowest device has finished its measurement. Then the trigger line can return to low
level and another trigger event can occur by a transition to high level.

6.4 Measure

Figure 6-24: Measure menu

The Measure menu covers all measurement modes that are provided by R&S NRPV.
Perform mode specific numerical measurements, trace measurement for pulse analysis and statistically evaluate power density and distribution. Several measurement
tasks can be operated simultaneously with data acquisition and evaluation visualized in
the graphical areas of the measurement windows.
A measurement starts immediately by selecting a measurement mode. Set measurement parameters, mathematical operands, display settings and view the results during
measurement. Assign modifications with the "Apply" button provided in each dialog.
Select one of the listed measurement modes:

6.4.1 Measure - Functions
Trace
Trace opens the trace measurement window for pulse analysis.
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Statistics
Statistics opens a measurement window for evaluating the ratio of the signal density
and distribution versus power. Determine the density and distribution with the aid of
markers.
Continuous, Gated, Timeslot or Burst Average
Select a numerical measuring mode as e.g continuous, gated, burst or timeslot.
For these measuring modes the measurement windows are almost similar, why the
description under Chapter 6.4.4, "Numerical", on page 138 applies to all modes. Special features are described explicitly.
"Continuous"

Select the measurement configuration dialog to set the parameters
for continuous power measurement.

"Gated"

Open the configuration dialog for gated power measurement. Measure the power with periodic envelope over defined time gates. Specify time intervals to be excluded from measurement.

"Timeslot"

Enter the configuration dialog covering parameters for timeslot measurement. Use this mode to measure the power of any complex signal in defined time segments simultaneously.

"Burst Average"

Pop up a measurement window to measure the burst power of a
modulated pulsed signal.

Start /Stop
Starts or stops measurement, see Chapter 6.6, "Start / Stop Measurement",
on page 167.
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6.4.2 Trace

Figure 6-25: Measure > Trace window

In the Trace mode, the R&S NRPV analyzes the power envelope of the test signal and
displays the power envelope as a function of time. Displaying the signal graphically as
with an oscilloscope, trace mode is particularly suitable for recognizing stable triggering
of modulated signals during measurement.
Trace measurement is available in many R&S power sensors, e.g. the multipath power
sensors R&S NRPxxS(N), NRP-Z1x and NRP-Z2x, except of NRP-Z27 and in the
NRP-Z8x wideband power sensors. These sensors provide a graphical display of
envelope power versus time.
The trace dialog covers the following panels:
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6.4.2.1

Trace - Functions

Display panel
Indicates the measurement result in power versus time. The display is divided into the
Graph in Trace Mode, showing the diagram with grid, markers trigger delay and level
information, and the Diagram Description Bar with information on the configured
traces.
Control panel
The control panel shows all parameters that are relevant for the display. It contains buttons to call sub dialogs for Trace, Maths, Diagram and Marker configuration as well as
entry fields for setting power and time scaling, trigger and some miscellaneous parameters.
Trace...

Opens the dialog for configuring trace parameters, see Chapter 6.4.2.5, "Measurement
Configuration ", on page 103. Select trace, color, view, channel and measurand, and
apply max hold, averaging and measurement type to the appropriate channels.
Math...

Open the dialog for configuring math parameters and operands, as described in Chapter 6.4.2.6, "Math Configuration", on page 105. Select channel, color, view and mathematical operation and apply max hold and measurement type to the appropriate channels.
Diagram...

Open the dialog for Diagram Configuration). The configuration dialog is divided in several tabs, which are described in Chapter 6.4.2.9, "Diagram Config. > Axes",
on page 109, Chapter 6.4.2.10, "Diagram Config. > Gates/Timeslots", on page 111,
Chapter 6.4.2.11, "Diagram Config. > Pulse", on page 112 and Chapter 6.4.2.12, "Diagram Config. > Plot", on page 114.
Marker...

Marker opens the dialog for setting the position of a marker and its value in the display
and show or hide delta values.
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Power, Move/Zoom, Time, Trigger, Other

Figure 6-26: Measure > Trace > Control panel

The control panel contains the parameters to configure the trace measurement window.
For information on how to set the parameters, refer to:
● Chapter 6.4.2.15, "Power Scale", on page 119
● Chapter 6.4.2.16, "Move/Zoom", on page 120
● Chapter 6.4.2.17, "Time Scale", on page 122
● Chapter 6.4.2.18, "Trigger", on page 122
● Chapter 6.4.2.19, "Other Section", on page 123
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Measurements panel

Figure 6-27: Measure > Trace > Measurements panel

Measurements Panel > Trace Measurement includes tabs with parameters listed for
timeslot, gates and pulse measurements. View the values of the currently shown measurement.
6.4.2.2

Graph in Trace Mode

Figure 6-28: Measure > Trace > Graph

The results window graphically represents the envelope power versus time. Shaped as
an oscilloscope display, the results window indicates:
●

diagram description bar

●

Y axis, indicating power in dB or W
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●

X axis with times scale in s

●

dotted gridlines

●

a white arrow showing the reference power

●

a white arrow showing the reference time

●

relative labels for the scale

●

trigger delay

●

trigger level

●

markers

●

graph, indicating the result

●

gates and timeslot lines

For detailed information on the symbols refer to Chapter 5.1.6.1, "Info and Symbols",
on page 64.
6.4.2.3

Diagram Description Bar

Figure 6-29: Measure > Trace > graph description bar

The diagram description bar indicates various information on trace configuration. For
example, a selected channel or a math operation. The displayed symbols, values and
additional information are each identified by their assigned colors. For example, the
color of a value in a description box corresponds to the set color for measurement and
graph. The arrow at the beginning or at the end of the diagram description bar indicates that not all info on the screen can be displayed. Click the respective arrow to
scroll through the description bar. For detailed information on the symbols of the
description bar refer to Chapter 5.1.6.1, "Info and Symbols", on page 64.
6.4.2.4

Context-sensitive Menu in Trace Mode
R&S NRPV provides a context-sensitive menu in the results window of the trace measurement window. Open the context menu by pressing the right mouse button.
The context-sensitive menu of the trace measurement window mainly covers configuration functions which alternatively are accessed via the control panel, the menu bar or
the toolbar.
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Figure 6-30: Measure > Trace > Context sensitive menu

The dialogs and parameters are described in the appropriate chapters of this operating
manual. The following table lists the context-sensitive menu items and refers to the
corresponding descriptions.
Menu item

Described in section ...

Print / Copy To Clipboard

Chapter 5.1.1.3, "Print or Copy to Clipboard", on page 49

Trace Configuration...

Chapter 6.4.2.5, "Measurement Configuration ", on page 103

Math Configuration...

Chapter 6.4.2.6, "Math Configuration", on page 105

Diagram Configuration...

Chapter 6.4.2.7, "Diagram Configuration", on page 107

Marker Configuration...

Chapter 6.4.2.13, "Marker", on page 115

Show Focus Values

Chapter 6.4.2.9, "Diagram Config. > Axes", on page 109

Show Trigger Level

Chapter 6.4.2.18, "Trigger", on page 122

Move/Zoom

Chapter 6.4.2.16, "Move/Zoom", on page 120

Move Freely
Move Horizontal only
Move Vertical only
Zoom In
Fixed Trace
Zoom Out
Power Auto Scale

Chapter 6.4.2.15, "Power Scale", on page 119

Reset Time Axis

Chapter 6.4.2.17, "Time Scale", on page 122
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6.4.2.5

Measurement Configuration

Figure 6-31: Measure > Trace > Meas configuration

The trace configuration dialog provides configuration of up to four channels for sensors
that support trace measurement. View selection boxes activate displaying the measurement results of each channel separately. Also, independently of each other, the following parameters are provided for each channel:
●

Measurand selection

●

Max. Hold measurement

●

Averaging settings

●

Selection of the measurement modes Pulse, Marker, Gate and Timeslot.

Trace 1 - 4
Indicates 4 available trace measurements.
Note: Channel Duplication.
In case the same trace measurement is assigned to a second trace, an error message
pops up.

It is possible to perform e.g. an average measurement on one trace and a peak measurement on a second trace within the same channel.

User Manual 1173.0314.02 ─ 07

103

R&S®NRPV

Settings - GUI Reference
Measure

Channel
Select a particular channel of the signal to be measured and displayed in trace mode.
Select one of at maximum 4 channels from the list, containing only channels that provide trace measurements.
Note: The view checkbox is enabled automatically, if a channel is selected.
Measurand
Select a channel-specific measurand. Since each point represents a time interval usually comprising many samples, the NRP-Z8x wideband power sensors provide selecting what is to be displayed.
"Average"

Select the average power for display. Average power features flicker
free display and a smooth trace.

"Peak"

Select the highest power measured.

"Random"

Select the power of a randomly selected sample. Random power provides a realistic display with signal details.

Max Hold
Set Max hold functionality. Max hold records the highest value measured for each
point, independent from Average, Random or Peak measurement. The maximum measured value is displayed.
Note: Click "Hold Reset" button in the control panel to reset the stored values, see also
Chapter 6.4.2.19, "Other Section", on page 123. Alternatively disable max hold checkbox and enable again to restart maximum value recording.
View graphically
Activate the trace for indication in the graph.
Averaging
Enable manually setting of the averaging count. The averaging count sets the number
of traces to be evaluated to form the measurement result. In manual mode the sensor
uses the averaging factor set in the averaging count entry field. In auto mode the sensor determines the optimum average filter count internally based on the given resolution (0.01 dB).
Note: The following averaging count entry field is enabled only, if averaging is activated.
Avg. Count
Enter the number of values that have to be averaged to form the measurement result.
The greater this averaging factor, the less the measured values fluctuate and the longer the measurement time. The entered averaging count value is rounded off to the
nearest power of 2. Use the Up & Down arrow buttons to increment / decrement the
averaging count, also rounded to the next higher / lower power of 2 values. Increasing
averaging count reduces signal variations and noise.
The changed averaging count is transferred to the corresponding sensor, featuring the
following configurations:
● Avg. count < Min.: Averaging count is set to minimum and the decrement button is
disabled.
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●

Avg. count > Max.: Averaging count is set to maximum and the increment button
is disabled.

Note: If there is Min or Max count set automatically, no error messages are reported.
Measurements
Select the modes to be displayed.
Pulse ← Measurements
Enable the pulse measurement mode, described in Chapter 6.4.2.11, "Diagram Config.
> Pulse", on page 112. The corresponding pulse parameters are displayed in the trace
measurement window.
Gate Avg. ← Measurements
Enable the gate average measurement.
Gate Peak ← Measurements
Enable the gated peak measurement mode, see Chapter 6.4.2.10, "Diagram Config. >
Gates/Timeslots", on page 111. The corresponding measurement configuration is displayed in the measurement window.
Gate pk/avg. ← Measurements
Enable the gated peak average measurement mode. The corresponding measurement
configuration is displayed in the measurement window. Refer to Chapter 6.4.2.10, "Diagram Config. > Gates/Timeslots", on page 111.
Timeslot Avg. ← Measurements
Enable the timeslot measurement mode, described in Chapter 6.4.2.10, "Diagram Config. > Gates/Timeslots", on page 111. The corresponding measurement configuration
is displayed in the measurement window.
6.4.2.6

Math Configuration

Figure 6-32: Measure > Trace > Math configuration
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R&S NRPV can combine measured values from several sensors, using mathematical
functions. The math configuration dialog provides configuration of up to four math
channels for multichannel measurement. Each of the four channels can be assigned to
the same or to different sensors. If multiple channels use the same sensor, the measurement is performed only once. The result is reused for the other channels. View
selection boxes activate displaying the measured and computed results of each math
channels. Additionally, the following parameters are provided for each channel:
●

Feed 1 and Feed 2 selection of the available channel traces

●

Selection of math operation

●

Max. Hold function

●

Selection of the measurement modes Pulse, Gate and Timeslot.

Math operands can be an absolute channel or a constant that is always interpreted in
Watt.
Math 1 - 4
Indicates 4 math measurement channels.
Feed 1, 2
Select an available trace, a trace memory or a constant channel for the first and for the
second operand.
Note: Both operands can neither be the same channel nor constant values.
"Feed 1"

Select the channel to be used to calculate the displayed value.

"Feed 2"

Select the second channel which is to be used for calculation.

Operation
Select a mathematical function to operate the measurement results of feed 1 and feed
2.
"SWR"

Compute the standing wave ratio from the first and the second measurement by using the following equation:
SWR = (1+RC) / (1-RC)
The measurement is performed in logarithmic scale.
Note: The forward power must be measured in the first channel and
the reverse power must be assigned to the second channel.
RC is the reflection coefficient, internally calculated from the measured power values P1 in channel 1 and P2 in channel 2.
RC = 10(P1 - P2) / 20

"Diff"

Subtract the measured power in the second channel from the power
of the first channel. The calculation, performed in linear scale is converted to logarithmic scale. Displayed unit is dB.

"Ratio"

Build the ratio of the power in the first channel to the power in the
second channel. Internally the ratio is performed by subtracting the
measured power values in logarithmic scale. Displayed unit is dB.
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View
Select the math channels to be viewed on trace display. On selecting a math channel,
Math trace plot is displayed in the measurement window.
Max Hold
Set Max hold functionality. Max hold records the highest value measured for each
point, independent from the selected operation. The maximum measured value is displayed.
Note: Enable max hold to reset the stored values. Activating again restarts maximum
value recording.
In the measurement section of the dialog, the trace measurements are activated. Then
the measurement can be indicated in the diagram.
In the measurement section of the math configuration dialog, measurements are activated. Then the results can be indicated in the diagram.
Measurements
Assign the math function to the measurement modes.
Pulse ← Measurements
Enable the pulse measurement mode. The corresponding pulse parameters are displayed in the trace measurement window, as described in Chapter 6.4.2.11, "Diagram
Config. > Pulse", on page 112.
Gate ← Measurements
Enable the gate measurement mode. The corresponding parameters are displayed in
the trace measurement window, as described in Chapter 6.4.2.10, "Diagram Config. >
Gates/Timeslots", on page 111.
Timeslot ← Measurements
Enable the timeslot measurement mode under Chapter 6.4.2.10, "Diagram Config. >
Gates/Timeslots", on page 111. The corresponding measurement configuration is displayed in the measurement window.
6.4.2.7

Diagram Configuration
The diagram configuration dialog provides configuration of the trace measurement
result window. All functions directly relate to the graphical data representation and do
not affect sensor settings.
The dialog covers tabs for parameter settings to:
●

Select the unit the results shall be displayed in Chapter 6.4.2.8, "Diagram Config. >
Unit", on page 108.

●

Define scale and resolution of the axes under Chapter 6.4.2.9, "Diagram Config. >
Axes", on page 109.

●

Set gates or timeslots to be viewed on the trace window in Chapter 6.4.2.10, "Diagram Config. > Gates/Timeslots", on page 111.

●

Select the pulse parameters to be indicated, seeChapter 6.4.2.11, "Diagram Config. > Pulse", on page 112.
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●

6.4.2.8

Design the trace display window in Chapter 6.4.2.12, "Diagram Config. > Plot",
on page 114.

Diagram Config. > Unit

Figure 6-33: Measure > Trace > Diagram configuration

The unit tab of the diagram configuration dialog contains the entry fields for assigning
unit and resolution to the y-axis. Trace data can be viewed in linear scale [Watt] or logarithmic scale (dBm).
Absolute/Relative
Set the unit for the y-axis the result is to be displayed. Electrical power is measured in
W and usually converted to logarithmic scale. For a relative power level, the measured
value is related to a reference power. The ratio is expressed in terms of the log of that
ratio. The unit of the power ratio is dB. An absolute power level is referred to 1 mW and
expressed in dBm.
The units of the displayed parameters of the y-axis change according to the selected
unit, i.e. Min power, Max power, Rev power and power/Div are adjusted.
"dB, dBm"

Assign a logarithmic scale to the y-axis to display power ratio.

"Watt, 1"

Assign a linear scale to the y-axis for displaying absolute power values.

"dBµV, dB"

Assign a logarithmic scale to the y-axis to display voltage ratio.

Resolution (Table)
Set a resolution for the unit of the y-axis. The precision of the displayed result depends
on the selected unit.
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6.4.2.9

Diagram Config. > Axes

Figure 6-34: Measure > Trace > Diagram > Axes

The Axes tab of the diagram configuration dialog provides setting scale, resolution and
position of the axes. Set the absolute values, position and grid of the reference markers, and switch on or off their display. The X axis time scale is divided into 10 equal
divisions. The same applies to the power scale of the Y axis.
Set value and scale directly in the control panel
Change Reference Time and Time/Div for the X axis directly by using the entry fields
and the plus and minus buttons in the control panel of the trace measurement dialog
and, the same way, change Reference power and Power/Div for the Y axis.
For additional description refer to Chapter 6.4.2.15, "Power Scale", on page 119 and
Chapter 6.4.2.17, "Time Scale", on page 122.
X axis
Set Reference time, position and grid of the time axis. In trace measurement X axis
represents the measuring time. The X axis features delayed and physical trigger markers, ruler and focus line. Delayed trigger marker always represents the 0 seconds in
the X axis, and it is common to all the channels within the trace display. The number of
physical trigger markers is equivalent to the number channels within the trace display.
The reference time as focus is attached to the grid, graphically depicted as an arrow.
The value does not move with trace nor does it move relative to markers, and it is independent of the number of channels. The total length of axis is determined by the Reference time and Time/ div. The scale minimum depends on the trace offset ranges, and
the scale maximum depends on the trace measurement time ranges of all sensors that
are selected for the measurement.
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Reference Time ← X axis
Specify the reference time of the trace results window. The reference time represents
the absolute center of the scale. This setting affects the graphical data representation
in the application and also the measurement and sensor configuration.
Reference Position ← X axis
Set the position of the reference time within the trace results window.
Time/Div ← X axis
Define the time value of one X axis division. Enter value and unit. R&S NRPV uses a
fixed grid of 10 divisions for the X axis. The time resolution is set per division with the
lowest possible value of 5 ns/div. Decimal precision more than 3 decimal places is truncated in the display.
Note: Not all sensors support the same time resolution. Additional information can be
found in the sensor data sheets. R&S NRPV automatically corrects invalid ranges for
the current sensor.
Based on the X scale range, Time/Div is validated featuring the following configuration:
● Time/Div < Min.: Minimum value is set per division.
● Time/Div > Max.: Maximum value is set per division.
Note: If the start value is set automatically, no error messages are reported.
Y Axis
Set Reference power, position and grid of the level axis. The Y scale is defined by the
two parameters reference level and level step per division. The Y-axis shows the unit of
measurement selected in the unit tab. Both values can be entered manually in logarithmic or linear scale.
Reference Level ← Y Axis
Specify the upper limit of the trace results window. This setting only affects the graphical data representation in the application and has no influence on the measurement or
sensor configuration.
Reference Position ← Y Axis
Set the reference position.
Power/div ← Y Axis
Define the power value of one Y axes division. Enter value and unit. Unit depends on
the setting selected in the unit tab. Decimal precision more than 3 decimal places is
truncated in the display. Based on the Y scale range, Power/Div is validated featuring
the following configuration:
● Pow/Div < Min.: Minimum value is set per division.
● Pow/Div > Max.: Maximum value is set per division.
Note: If the start value is set automatically, no error messages are reported.
Show reference values
Show the numerical values of the reference parameters. The values are displayed right
next to the arrows of the reference markers.
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6.4.2.10

Diagram Config. > Gates/Timeslots

Figure 6-35: Measure > Trace > Diagram > Gates/Timeslots

The Gates/Timeslots tab of the trace diagram configuration dialog provides selecting
gates and timeslots for measurement and view. For display in trace mode gates and
timeslots parameters are configured at the same time.
Gates
View and measurement check boxes activate measuring and displaying the measurement results in the trace measurement window. Provides 4 available trace measurements.
View ← Gates
Enables the gate view of the trace measurement window. R&S NRPV displays the
active gate in the diagram as dashed lines. Gate parameters as start time, length and
fence settings are defined in Chapter 6.2.12, "Gates", on page 87.
Measure ← Gates
Activate the gates for measurement. R&S NRPV lists the measured values for each
selected gate in the Gates tab of the measurements panel.
Timeslots
A view checkbox activates the display of timeslots in the trace measurement window.
Select a particular timeslot for indicating the measured value.
View ← Timeslots
Enable to view the timeslot on the trace window. R&S NRPV displays the active timeslots in the diagram as dashed lines. The number of timeslots is defined in Chapter 6.2.11, "Timeslots", on page 85.
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Measure ← Timeslots
Select a timeslot for indicating the measured value in this particular time interval.
R&S NRPV indicates the measured values of the appropriate channels in the timeslot
tab of the measurements panel.
6.4.2.11

Diagram Config. > Pulse

Figure 6-36: Measure > Trace > Diagram > Pulse

In the "Pulse" tab of the trace diagram configuration window, you can enable specific
pulse measurement values for display. The measurement parameters are grouped as
follows:
●

Pulse Times, covering duration, period and duty cycle

●

Rising Edge, including rise time, pulse start time and overshoot

●

Falling Edge, including fall time, pulse stop time and overshoot

●

Pulse Power with top, base, distal, mesial and proximal power parameters

●

Signal Power, covering peak, average and minimum power

Table 6-3: Select the checkbox to enter one of three possible states:
Check Show the value in the table of the measurement panel.
Show Graphically represent the value in the diagram and show the value in the table.
Note: A parameter, which cannot be graphically displayed, supports only check or uncheck.
Uncheck Do not show the value.

Pulse Times
Contains parameters for information on characteristic times of a pulse.
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"Pulse Duration"

(Mesial power) Displays the pulse width.
Note: Usually the interval between the 50% points of the final amplitude is used to define pulse duration.

"Pulse Period"

Displays the time the pulse signal needs to complete one cycle.

"Duty Cycle"

Indicates the duty cycle of the measured power. If a duty cycle of a
pulsed signal is measured, the R&S NRPV displays the average
power in the pulse.

"Equivalent
Sampling
Period"

Indicates the duty cycle of the equivalent sampling period.

Rising Edge
Contains falling edge signal parameter to be displayed.
"Rise Time"

Indicates the time required for the signal to change from low value to
high value.

"Pulse Start
Time"

Displays the start point of the current pulse, i.e. the time when the
signal crosses the medial reference level.

"Overshoot"

Indicates when the final value is exceeded.

Falling Edge
Contains falling edge signal parameter to be displayed.
"Fall Time"

Indicates the time required for the amplitude of a pulse signal to
change from high value to low value.

"Pulse Stop
Time"

Displays the end point of the current pulse, i.e. the time when the signal crosses the medial reference level.

"Overshoot"

Indicates when the final value is exceeded.

Pulse Power
Contains pulse power parameters to be displayed.
"Top Power"

Indicates the power of a complete pulse, including rising and falling
edges.
Note: This function is provided by NRP-Z81/Z85/Z86 power sensors
only.

"Base Power"

Indicates the base power, computed in the pulse level analysis histogram of the trace data.

"Distal Power"

Indicates the absolute power value of the high reference level.

"Mesial Power" Indicates the absolute power value of the mid reference level.
"Proximal
Power"

Indicates the absolute power value of the high reference level.

Signal Power
Contains parameters for continuous signals to be indicated.
"Peak Power"

Indicate the measured peak power.

"Average
Power"

Indicate the measured average power.
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"Minimum
Power"
6.4.2.12

Minimum power value of the signal.

Diagram Config. > Plot

Figure 6-37: Measure > Trace > Diagram > Plot

The "Plot" tab in the trace diagram configuration dialog covers parameters for designing the trace measurement display. Set screen resolution and grid lines and assign the
label to the measurement window in this dialog.
Horiz. Resolution
Set a number of trace points for the horizontal resolution. This setting is valid for all
traces. R&S NRPV synchronizes an updated resolution with the sensor. Based on the
minimum trace points, resolution is validated featuring the following configuration:
● Horiz. Resolution < Min.: Minimum resolution is set.
● Horiz. Resolution > Max.: Maximum resolution is set.
Note: In case of resolution value set automatically, no error messages are reported.
Grid lines
Set grid lines to be displayed or hidden.
Name
Apply a designated name to the trace measurement window.
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6.4.2.13

Marker

Figure 6-38: Measure > Trace > Marker dialog

In trace mode, any number of markers can be defined. Markers can be assigned to
trace points for performing automated measurements.
You can use markers for various tasks, e.g. to define a delta to a level or a frequency
value, to refer to a reference value, or to determine the peak. The settings in the
marker dialog provide therefore countless variations.
Markers can be defined in the "Marker Configuration" dialog, which can be started by
pressing
in the configuration panel.
Initially no markers are defined. Press

to add a new marker.

(Marker) Name

Assign a marker name.

View

Indicate the marker in the graph.
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Line, Trace, Math

Refer to a marker line, a trace-related marker or a math trace-related marker.

Ref. Marker

Determine an additional reference to, e.g., an already defined marker, or a
function.
This reference is used to position the current marker.

Function

Determine the task of the marker.
The possible values depend on the settings of Line, Trace and Math. A table
with available combinations can be found below.

Result refers to

Determine an additional reference to, e.g., an already defined marker, or a
function. This reference is used to calculate marker results of the current
marker relative to.
By default, the marker results refer to the reference marker. It is rarely helpful
to define separate reference markers for positioning and result evaluation.
Add or remove a marker
Display the marker's names in the graph that are activated in the "View"
checkbox.

Name

Assign an individual name to the marker dialog.

Save/Load

Save or restore a marker configuration.

All values and parameter of the markers are shown in the marker panel underneath the
diagram. Additionally, you can change the function values directly in the graph by
selecting and dragging with the mouse pointer.
Marker functions in detail
Table 6-4: Marker functions
Line, Trace,
Math

Ref. Marker

Function

Application

Line

None

Fixed Time

Vertical Marker Line

Fixed Power

Horizontal Marker Line

<Any Trace>

<Any Marker>

Rel. Time. and/or Rel. Marker line relative to another marker value
Power depending on
reference marker type

None

Fixed Time

Marker showing the power at a dedicated
point of time

Auto Peak

Marker "riding" on the current peak of a trace

Rel. Time

Marker time shifted to the Ref. marker

Rel. Power <-

Marker at the next position left to reference
marker where relative power is reached

Rel. Power ->

Marker at the next position right to reference
marker where relative power is reached

<Any Marker>
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Line, Trace,
Math

Ref. Marker

Function

Application

Next Peak <-

Marker at the next peak left to reference
marker

Next Peak ->

Marker at the next peak right to reference
marker

The math traces are handled the same way.
6.4.2.14

Example How to Use Markers
The example deals with two pulse traces. With the marker functionality, the R&S NRPV
measures the interval between the two pulses.

Figure 6-39: Marker example > two traces carrying pulses

To define the markers:
1. Set the first marker to indicate the peak of "Trace 1" (the blue trace)

Figure 6-40: Marker example > 1st marker

2. Set the second marker similarly for "Trace 2" (the yellow trace with the delayed
pulse):
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Figure 6-41: Marker example > 2nd marker

3. Set marker number three to detect the pulse start by searching the -3 dB point left
to the peak.

Figure 6-42: Marker example > 3rd marker

4. Set the last marker accordingly for the yellow trace.

Figure 6-43: Marker example > 4th marker

Note: The reference marker for result evaluation is not the same used for positioning.
In this case, we want to know the distance to the third marker "Start of Blue".
The marker results including the pulse distance are shown below the trace display:
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Figure 6-44: Marker example > traces with defined markers

The pulse distance is shown in the section of "Start of Yellow > Result refers to >
Rel. Time""Rel. Time"The interval between the two pulses is 568.859 µs.
6.4.2.15

Power Scale

Figure 6-45: Measure > Trace > Power scale

This section provides to set the reference power level and the Y axis power scale division directly. The Y scale can be represented logarithmic or linear, defined in Chapter 6.4.2.8, "Diagram Config. > Unit", on page 108.
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Reference Power
Adjust reference power as the upper limit by either directly entering the value or incrementally shift the level using the plus minus buttons. Alternatively, set the reference
power level under Diagram Config. > Axes.
Note: This setting only affects the graphical data representation and has no influence
on the measurement.
Auto

Initiate Auto scaling for the Y axis. The lower and upper limit values are computed
according to a special algorithm. Considering all viewed traces the algorithm determines the minimum and maximum values of all the signals.
R&S NRPV updates the parameters, listed below:
● Y start, Y spread and Y stop
● Reference position marker, based on Y start change
● Trigger bar
● Y min power, Y max power and Y power/ div
● Reference position (grid value) fields in the diagram configuration
● Trace plots
Depending on the defined unit and the connected sensors, different routines are computed to determine the scaling automatically.
Power / Div
Set the power range of one Y axis division. Either directly enter a value or increment /
decrement the size in fixed steps using the up and down arrow buttons. Alternatively,
set the Y axis division in Diagram Config. > Axes.
6.4.2.16

Move/Zoom

Figure 6-46: Measure > Trace > Move/Zoom

Covers a list for configuring the mouse movement and zoom functionality in the trace
results window.
Power/Div sets the scaling of the Y axis. Changing this value is always done by keeping the reference power constant and adjusting the visible power limits accordingly.

Figure 6-47: Measure > Trace > Move/Zoom list
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Additional adjustments during Zoom In
R&S NRPV does not just graphically perform zoom in operation but reconfigures the
sensors and trace parameters to provide more detailed information on the measurement results.
Move / Zoom
Selects the zoom functionality.
"Move Freely"
Freely changes the position of traces within the results window.
R&S NRPV adjusts affected values automatically, and even provides
moving the graphs.
How to proceed:
● Set the cursor to the position you want to move.
● Capture a trace by pressing the left-hand mouse button
● Keep the button pressed.
● Move the trace to the requested position.
● Release the mouse button to drop the trace at its new position.
"Move Horiz. only"
Changes the position of traces within the results window in horizontal
direction. Proceed the same way as described.
"Move Vert. only"
Changes the position of traces within the results window in vertical
direction. Proceed as described .
"Zoom In"
Freely selects any section to be zoomed in the results window.
How to proceed:
● Set the cursor to the start point.
● Press the left-hand mouse button, and keep it pressed.
● Drag a rectangular shape around the area to be zoomed in.
● Release the mouse button to execute zooming.
Note: In this way, you can zoom in the display in several steps. Using
"Zoom out" button, you can return to the previous size. To reset the
zoom select the "Zoom Out" button.
The R&S NRPV does not graphically perform zoom in operation but
reconfigures the sensors and trace parameters to provide more
detailed information on the measurement results.
"Fixed Trace"
Fix the trace configuration of the current measurement. Moving or
zooming the trace with the mouse is disabled.
Zoom Out

Returns the scaling to the size before zooming in. If zooming in has been performed in
several steps, zooming out operates the same way reversely.
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6.4.2.17

Time Scale

Figure 6-48: Measure > Trace > Time Scale

This section provides to set the reference time and the X axis time scale division
directly.
Modification of time scale parameters is only possible for linear scale.

Reference Time
Set reference time by either directly entering the value or by using the up and down
arrow buttons. The two buttons increase or decrease the time in fixed steps. The
appropriate unit is added automatically to the value. Alternatively, set the reference
time under Diagram Config. > Axes.
Reset

Set reference time and reference position to default values.
Time/ Div
Set the time span of one X-axis division. Either directly enter the value or increment/
decrement the size in fixed steps using the up and down arrow buttons. Alternatively
set the X-axis division in Diagram Config. > Axes.
6.4.2.18

Trigger

Figure 6-49: Measure > Trace > Trigger

Contains a drop-down list to select the trigger mode.
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Auto

Automatically starts a mefasurement if no trigger event has occurred after 300 ms.

Continuous

Continuous triggering with regular trigger events.

Single

This setting disables continuous triggering so that only one trigger event at time is executed. To enable triggering, press the 1Trig key. The symbol Trigger sequence control
appears in the display.
The trigger sequence control is used to control the trigger sequence manually.

1Trig

Initiate a single trigger event manually. 1Trig captures the signal irrespective of the trigger level and applies the trigger event to all channels in the trace window.
Depending on the state of the Trigger mode, 1Trig initiates different events:
● Single deactivated Stop a running measurement, or a restart a stopped measurement.
● Single active First selection of Trig1 enables triggering and starts measurement. A
second stroke initiates one trigger event. The next stroke switches to manual triggering.
Show Level
Show the trigger level line in the display.
Note: Show level only concerns indicating the trigger level line. Trigger level symbols
are permanently displayed, even if show trigger level is deactivated.
Settings

Settings opens the trigger configuration dialog to set the appropriate trigger parameters.
6.4.2.19

Other Section

Figure 6-50: Measure > Trace > Other

Contains a reset button for restarting max hold function.
Hold Reset
Resets the recorded max hold values and then restart Max Hold operation. For information on max hold function, see Chapter 6.4.2.5, "Measurement Configuration ",
on page 103.
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6.4.2.20

Measurements Panel > Trace Measurement

Figure 6-51: Measure > Trace > Measurements

The measurements panel consists of separate tabs which contain the significant
parameters for timeslot, gates and pulse power measurement, and NdB down and
marker parameters. R&S NRPV displays the currently measured values.
Measurements
Contains the parameters for configuring the parameters for timeslot, gates and pulse
power measurement.
Timeslots ← Measurements
Display the currently measured power level of a selected timeslot. Select the timeslot
for indicating in Diagram Config. > Gates/Timeslots.
Gates ← Measurements
Show the currently measured values of the selected gates. Display the values of av
(average power), pk (peak power) and the ratio of pk/av. Select the timeslot for indicating in Diagram Config. > Gates/Timeslots.
Pulse ← Measurements
Display the currently measured values of the incoming pulse signal. Display the parameters selected in Diagram Config. > Pulse.
Marker ← Measurements
Display the settings of the markers selected for view in Marker.
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6.4.3 Statistics

Figure 6-52: Measure > Statistics window

In the Statistics mode, the R&S NRPV analyzes the power envelope of the test signal
and returns an array of statistic values. Power envelope in its distribution and distribution density function is displayed. Statistically analyzing the envelope power requires
trace measurement of the signal. The measurement covers one time interval and is
repeated until the desired number of samples is attained. Multiple statistic measurements can be performed simultaneously.
The NRP-Z8x wideband power sensors provide to display the amplitude distribution as
CCDF, CDF or PDF graphically.

6.4.3.1

Statistics - Functions
The "Statistics" dialog covers the following functions.
Display panel
Displays the results of power measurement statistically, that means the distribution or
the distribution density. The display is divided into the Chapter 6.4.3.2, "Graph in Statistics Mode", on page 127, showing the diagram with grid, markers and measurement
graph, and the Chapter 6.4.3.3, "Diagram Description Bar", on page 127 with information on the configured measurements.
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Control panel
Shows all parameters that are relevant for the display. It contains buttons for accessing
measurement, diagram and marker configuration sub dialogs, as well as entry fields for
directly setting power and distribution scaling, distribution function and some miscellaneous parameters.
Meas...

Opens the dialog for Measurement Configuration. Select color, view and channel of up
to 4 configurable measurements. Set markers and AWGN distribution to be displayed
and select acquisition and distribution functions.
Diagram...

Opens the dialog to configure statistics display. Define the settings of the axes in Diagram Config. > Axes and apply plot settings in Diagram Config. > Plot to design the
display and output of the measurement results.
Marker...

Opens the dialog to set the position of the X and Y markers and their values in the display. For detailed description, refer to Chapter 6.4.3.8, "Marker", on page 134.
Scale, Move/Zoom, Gate, Distribution Function and AWGN
Directly enter the values or select settings in the control panel. For description refer to
Chapter 6.4.3.9, "Scale", on page 135, Chapter 6.4.3.10, "Move/Zoom", on page 136
and Chapter 6.4.3.11, "Gate, Distribution Function and AWGN", on page 136.
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6.4.3.2

Graph in Statistics Mode

Figure 6-53: Measure > Statistics > Graph

The diagram area graphically represents the distribution or distribution density of the
envelope power. The results window indicates:
●

Diagram description bar

●

X axis, indicating power in dB or W

●

Y axis scaled in %

●

Dotted gridlines

●

A white arrow showing the average power

●

Relative labels for the scale

●

Markers

●

Graph, indicating the result and the additive white Gaussian noise distribution

For detailed information on the symbols, refer to Chapter 5.1.6.1, "Info and Symbols",
on page 64.
6.4.3.3

Diagram Description Bar

Figure 6-54: Measure > Statistics > graph description bar
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The diagram description bar indicates various information on statistics configuration,
like a selected channel or a distribution function. The displayed values and additional
information are each identified by their assigned colors, that means, the color of a
value in a description box corresponds to the color assigned to the measurement and
graph. An arrow at the beginning or at the end of the diagram description bar indicates
that not all info on the screen can be displayed. Click the respective arrow to scroll
through the description bar.
For detailed information on the symbols of the results window refer to Chapter 5.1.6.1,
"Info and Symbols", on page 64.
6.4.3.4

Context-sensitive Menu in Statistics Mode
R&S NRPV provides a context-sensitive menu in the results window of the statistics
measurement window. Open the context menu by pressing the right mouse button.
The context-sensitive menu of the statistics measurement window mainly covers configuration functions which alternatively are accessed via the control panel, the menu
bar or the toolbar. The menu also consists of functions as, e.g., Show Hide Markers,
Move/Zoom or Auto Scale. Show/Hide Markers and Move/Zoom provide submenus for
selecting further parameters.

Figure 6-55: Measure > Statistics > Context-sensitive menu

The dialogs and parameters are described in the appropriate chapters of this operating
manual. The following table lists the context-sensitive menu items and refers to the
corresponding descriptions.
Menu item

Described in ...

Print / Copy To Clipboard

Chapter 5.1.1.3, "Print or Copy to Clipboard", on page 49

Measurement Configuration

Chapter 6.4.3.5, "Measurement Configuration", on page 129

Diagram Configuration...

Chapter 6.4.3.6, "Diagram Config. > Axes", on page 132
Chapter 6.4.3.7, "Diagram Config. > Plot", on page 133

Marker Configuration

Chapter 6.4.3.8, "Marker", on page 134

Show/Hide Markers
Move Marker to Viewing Area
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Menu item

Described in ...

Move/Zoom

Chapter 6.4.3.10, "Move/Zoom", on page 136

Zoom Out
Auto Scale

6.4.3.5

Chapter 6.4.3.9, "Scale", on page 135

Measurement Configuration

Figure 6-56: Measure > Statistics > Meas configuration

In the "Configuration (Statistics Window)", you can configure up to four measurements
with sensors that support statistics measurement. View selection boxes activate displaying the measurement results. You can set channel and marker separately for each
measurement, as well as general parameters for acquisition, distribution and display of
the measurement results.
Measurement 1 - 4
Indicates 4 channels for statistics measurements.
Channel
Selects the channel. The list contains up to for channels, provided that the connected
sensors support statistics measurement.
Note: The "View" checkbox is enabled automatically, when you select a channel.
Note: Channel duplication. In case the same statistics measurement is assigned twice,
an error message appears.
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It is possible to assign one channel to a measurement only.
View
Select the measurement result to be viewed on display.
Marker
Define a marker for either power or for density/distribution and set the positions. With
the aid of markers, you can calculate scalar values at the marker positions.
X Marker ← Marker
View the marker, positioned to a power value in the measurement window. The value
of the distribution or the distribution density is measured and displayed.
Y Marker ← Marker
Display the marker, positioned to a value of distribution or distribution density. The
power is measured and displayed.
Acquisition
Configure data acquisition parameters to be performed by the R&S power sensor.
Total Samples ← Acquisition
Enter a minimum number of samples for statistics measurement. The parameter is
used to calculate the measurement time considering the minimum and maximum values of the connected sensors.
Measurand ← Acquisition
Selects the distribution function for signal measurement and display. R&S NRPV supports the distribution functions CDF, the CCDF and PDF.
Distribution Function Measurand

Figure 6-57: Distribution Function > Function list

Updates the sensor and the measurement configuration value. The sensor can be set
to deliver CCDF statistics data directly. CCDF shows the probability that the mean signal power will be exceeded. The probability is represented as % in the diagram, performed either in logarithmic or linear scale.
"CCDF (Log) "
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function with the results displayed in logarithmic scale.
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"CDF (Log) "

Selects the CDF (cumulative distribution function) in logarithmic
scale. The R&S NRPV updates the sensor using the CCDF function
and calculates the measurement results internally, by means of:
CDF=1-CCDF

"CCDF (Lin) "

Selects the CCDF function displayed in linear scale.

"CDF (Lin) "

Selects the CCDF function displayed in linear scale.

"PDF (Lin)"

Selects the PDF (probability density statistics) function. The graph
represents the power histogram in linear scale.

AWGN
Adds an ideal AWGN curve as reference to the statistics data display. The reference
curve relates to the average power and can be used with all statistics modes.
Free Run /Gate
Activates measurement with an immediately executed trigger event.
Note: "Free Run" mode disables "Gate" mode and vice versa.
"Free Run"

●

●

"Gate 1 ...4"
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Active
Free run performs continuous measurement during the selected
time interval, asynchronously to the waveform. If a measurement
is completed, the sensor is immediately set to initiated, waiting for
the next trigger event.
Deactivated
A measurement is performed only once. Use free running for the
first measurement of signals with unknown timing and level.

Select a particular gate to acquire measurement values. The measurement is performed synchronously over the selected gate.
R&S NRPV provides up to four gates for measurement. Statistic gate
parameters as statistics start time, length and fence settings are
defined in Gates.
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6.4.3.6

Diagram Config. > Axes

Figure 6-58: Measure > Statistics > Diagram > Axes

The "Axes" tab of the diagram configuration dialog covers entry fields for defining scale
and reference position for the X axis, and scale in dependency of the distribution function for the Y axis, respectively. In statistics measurement, the X axis represents the
power values, and the Y axis indicates the effective frequency of the values. The
scales of both axes are divided into 10 equal divisions.
X axis
Sets a reference position and grid of the power axis and determines the start value of
the power scale.
Power/Div ← X axis
Defines the power value of one division. Enter value and unit.
Reference Position ← X axis
The scale of the X axis is focused on the reference power, that means the average
power that is applied from the sensor of the appropriate channel. Minimum and maximum values of the grid cannot be entered directly. Relating to the reference position
and power/Div R&S NRPV calculates the start and end value of the scale, with:
Start = Reference Power – (Reference position * Power/Div.)
The scale values shown in power grid lines are relative values concerning to the reference power.
Y axis
Enters start value and grid of the probability axis referring to the distribution function.
For CCDF/CDF function scale unit is % in each case, for PDF function is dimensionless.
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CCDF & CDF ← Y axis
Covers the Y axis settings for the CCDF/CDF distribution function in %.
Min ← CCDF & CDF ← Y axis
Sets the start value of the probability axis for CCDF/CDF evaluation. Enter value and
unit.
Prob/Div ← CCDF & CDF ← Y axis
Defines the value of one Y axis division.
PDF ← Y axis
Covers the Y axis settings for the pdf distribution function.
Min ← PDF ← Y axis
Sets the start value of the probability axis for PDF evaluation. Enter value and unit.
Prob/Div ← PDF ← Y axis
Defines the value of one Y axis division.
Note: Modify Y axis parameters in linear scale only. Displaying the results in logarithmic scale, that means the CCDF or CDF function, the start and "<function>/Div" values
are fixed. Modification is only possible for linear scale.
6.4.3.7

Diagram Config. > Plot

Figure 6-59: Measure > Statistics > Diagram > Plot

The "Plot" tab in the statistics diagram configuration dialog covers parameters for
designing the statistics measurement display. In this dialog, you can configure the
screen resolution and grid lines, and assign a name to the measurement window.
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Horiz. Resolution
Sets the number of pixels to specify the horizontal resolution. This setting is valid for all
statistics measurements. The R&S NRPV synchronizes an updated resolution with the
sensor.
Grid lines
Sets grid lines to be displayed or hidden.
Name
Applies a designated name to the statistics measurement window.
6.4.3.8

Marker

Figure 6-60: Measure > Statistics > Marker

In statistics mode, you can assign markers to points for performing automated measurements. The marker configuration dialog covers entry fields for setting markers of
the x and y axis and to determine the position of marker information in the display.
X Marker Position
Sets the X marker position in dBm.
Y Marker Position
Sets the Y marker position in %.
Right Position ← Y Marker Position
Places the probability marker on the right position, otherwise the marker is positioned
on left-hand side.
Move to viewing area
Moves the X and Y markers in the result window when they are outside the limits of the
statistics window.
Position of values
Displays the marker values inside the grid, according to the selected location.
"Top left"
Displays the marker value list in the top left corner of the display.
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"Top right"
Displays the marker value list in the top right corner.
"Bottom left"
Displays the marker value list in the bottom left corner.
"Bottom right"
Displays the marker value list in the bottom right corner.
6.4.3.9

Scale

Figure 6-61: Measure > Statistics > Scale

In this section, you can directly set the start value and the scale division of the probability axis, and the X axis power value of a division.
The modification of Y axis parameters is only possible in linear scale.

Y Start
Sets the start value for indicating the probability. Alternatively, you can set the start of
the Y axis under Diagram Config. > Axes.
CCDF/Div
Sets the value of one Y axis division. You can either directly enter a value, or decrease
or increase the size in fixed steps using the up and down arrow buttons.
Auto
Sets automatic scaling for both of the axis. The parameters defining the axes are
determined according to the following settings:
● Default start and stop values for the Y axis CCDF/CDF function, and best fit values
for the PDF function.
● Default grid and spread values for X axis.
Power/Div
Sets the power range of one X axis division. Either directly enter a value or increment /
decrement the size in fixed steps using the up and down arrow buttons. Alternatively,
set the X axis division in Diagram Config. > Axes.
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6.4.3.10

Move/Zoom

Figure 6-62: Measure > Statistics > Move/Zoom

Covers a list for configuring the mouse movement and zoom functionality in the statistics results window.
Power/Div sets the scaling of the X axis. Changing this value is always done by keeping the average power constant and adjusting the visible power limits accordingly.
Move / Zoom
Selects the functionality for zooming in the statistics measurement window.
"Zoom In"
Freely selects any section to be zoomed in the results window.
How to proceed:
● Set the cursor to the start point.
● Press the left-hand mouse button, and keep it pressed.
● Drag a rectangular shape around the area to be zoomed in.
● Release the mouse button to execute zooming.
Note: In this way, you can zoom in the display in several steps. Using
"Zoom out" button, you can return to the previous size. To reset the
zoom select the "Zoom Out" button.
The R&S NRPV does not graphically perform zoom in operation but
reconfigures the sensors and trace parameters to provide more
detailed information on the measurement results.
"Fixed Trace"
Fixes the trace configuration of the current measurement. Moving or
zooming the trace with the mouse is disabled.
Zoom Out

Returns the scaling to the size before zooming in. If zooming in has been performed in
several steps, zooming out operates the same way reversely.
6.4.3.11

Gate, Distribution Function and AWGN
Selects the parameters for time gates and the distribution function, and activates the
AWGN graph in the display.

User Manual 1173.0314.02 ─ 07

136

R&S®NRPV

Settings - GUI Reference
Measure

Alternatively, you can define the parameters in the dialog Chapter 6.4.3.5, "Measurement Configuration", on page 129.
Gate

Figure 6-63: Measure > Statistics > Gate

Selects one of four gates. R&S NRPV transmits information to the sensor and updates
the measurement configuration. Statistic gate parameters as statistics start time, length
and fence settings are defined in Gates.
Note: Gate is available only if free run mode is disabled.
Distribution Function

Figure 6-64: Measure > Statistics > Distribution function

Selects the distribution function. R&S NRPV updates the sensor and the measurement
configuration. Set to CDF the application transmits CCDF to the sensor and computes
the CDF results internally.
Show Ref. Curve

Figure 6-65: Measure > Statistics > Show Ref

Activates AWGN reference curve to be displayed.
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6.4.4 Numerical

Figure 6-66: Measure > Numerical window

Numerical power measurement comprises continuous, gated, timeslot and burst measurements. The R&S NRPV provides for all modes separate measurement windows,
which are almost similar, except of the presentation of timeslot measurement. Every
result window has its respective tabs for relative, reset and auxiliary reset functions.
About the following description
In the following description, the information is valid for almost all numerical measurement modes. If there is a special feature for a specific mode, it is pointed out.
Timeslot mode settings are described separately.
The numeric windows for continuous, gated or burst power measurement contain the
following sections:
6.4.4.1

Numerical - Functions

Results windows
Results windows display the results numerically in the Results in Numerical Mode.
Timeslot mode features special display, described in Graph in Timeslot Mode.
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Configuration controls
The control panel contains buttons for access to further measurement dialogs, math
and diagram configuration.
Meas...
Opens the dialog for configuring measurement parameters. In this dialog, you can
select the measurement, the channel and view, and determine the measurand for display. For description, refer to Chapter 6.4.4.6, "Measurement Configuration > Continuous / Gate / Burst", on page 144.
Timeslot mode features special measurement parameters. These features are described in Chapter 6.4.4.7, "Measurement Configuration > Timeslot", on page 146.
Math...
Math Configuration opens the dialog to configure math parameters and to determine
operands for related measurements. You can define the unit, set relative measurement
and auxiliaries settings and apply styles to the results for display.
Display.../ Diagram...
Opens the dialog for configuring display settings, as described in Chapter 6.4.4.19,
"Display Configuration", on page 156. In this dialog, you can rename the measurement window, and define the background color and font settings. In timeslot measurement, the dialog contains the parameters to configure the axes and plot settings
accordingly.
Timeslot mode features special display. The characterizing values are described in
Chapter 6.4.4.20, "Diagram Config. > Timeslot > Axes", on page 157, and Chapter 6.4.4.21, "Diagram Config. > Timeslot > Plot", on page 158.
Gate Selection
Selects one of four gates. The R&S NRPV transmits information to the sensor and
updates the measurement configuration. Gate parameters as start time, length and
fence settings are defined in Gates.
For time gate average mode, the control panel includes an entry file for gate selection.

Note: Gate is available only if free run mode is locked.
Snapshot ← Gate Selection
Stores the current measurement value in a *.csv file. The R&S NRPV automatically
creates a file, assigns the file name, composed of the date, time and an abbreviation
for the measurement, and stores it in the application path under
%APPDATA%\Rohde-Schwarz\NRPV\Snapshots.
%APPDATA% is a system variable, representing drive and path of the application data of
your PC.
Further snapshots of the same date and measurement are continuously stored in this
file.
Note: Move the pointer over the button to find a Tooltip with information on directory,
path and file name.
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Table 6-5: Measurement abbreviations:
CA

Continuous Average

TG

Time Gate

BA

Burst Average

Measurements Panel
Note: Measurements panel refers to "Timeslot" measurement.
Displays power values available in a selected timeslot. For detailed description, refer to
Chapter 6.4.4.22, "Measurements Panel > Timeslot", on page 158.
6.4.4.2

Results in Numerical Mode

Figure 6-67: Measure > Numerical > Results window

The results field represents a digital meter indicating the main numeric value of measurement and auxiliary values, selected for view under Measurement Config. > Auxiliaries. An analog meter graphically represents the results. One measurement window
covers a maximum of 4 result fields, including both, absolute and math measurements.
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The main numeric result displays either the measurement value or the values resulting
from math operations. Based on unit, the result formats depend on absolute or relative
measurement. The auxiliary result displays up to three further values of absolute channel or math measurement results. The result formats depend on measurement mode.
Resolution is always 0.001 for auxiliary results.
According to channel, measurement and math operation, the result designation can
contain various information. For detailed information on the symbols, refer to Chapter 5.1.6.1, "Info and Symbols", on page 64.
6.4.4.3

Graph in Timeslot Mode

Figure 6-68: Measure > Numerical > Graph

The graphical timeslot average power view contains information listed below:
●

Bar chart with up to 8 active slots

●

Nominal width

●

Trigger level

●

Averaging filter count

●

Reference level

●

Marker measurement
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All bars are continuously updated. The update rate depends mainly on the set average
filter count. The higher the filter count, the lower the update rate and the noise level. To
the left of the timeslot results window a control panel provides entry fields for directly
setting the power levels of the scale.
If the readings in a bar exceed the upper value of the diagram, the R&S NRPV graphically indicates the overshoot by darkening the color of the respective bar.
Max power/ Min power
/
Sets minimum and maximum power value for display. Both entry fields provide the unit
of measurement selected in the unit tab.
The control panel shows all parameters that are relevant for the display. It contains buttons to call sub dialogs for measurement, diagram and marker configuration as well as
entry fields for directly setting power and distribution scaling, distribution function and
some miscellaneous parameters.
Auto

Initiates auto scaling for the power axis. The lower and upper limit values are computed according to a special algorithm. Considering all viewed timeslots the algorithm
determines the minimum and maximum values of all the results.
R&S NRPV updates the parameters, listed below:
● Y min power, Y max power and Y power/ div
● Reference position marker, based on Y start change
● Trigger bar
● Reference position (grid value) fields in the diagram configuration
Considering the defined unit and the connected sensor, the R&S NRPV determines the
scaling automatically.
6.4.4.4

Context-sensitive Menu for Numerical Measurement Modes
R&S NRPV provides a context-sensitive menu in the result field of a numerical measurement window, like continuous, gate or burst. Open the context menu by pressing
the right mouse button.

Figure 6-69: Measure > Numerical > Context-sensitive menu
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The context-sensitive menu of the numerical measurement window covers configuration functions, which alternatively can be accessed via the control panel, the menu bar
or the toolbar. Additionally, the Save Diagram function is included in this menu.
The dialogs and parameters are described in the appropriate chapters of this operating
manual. The following table lists the context-sensitive menu items and refers to the
associated descriptions.

6.4.4.5

Menu item

Described in ...

Print / Copy To Clipboard

Chapter 5.1.1.3, "Print or Copy to Clipboard", on page 49

Math Configuration...

Chapter 6.4.4.14, "Math Configuration", on page 152

Display Configuration...

Chapter 6.4.4.19, "Display Configuration", on page 156

Context-sensitive Menu in Timeslot Mode
The R&S NRPV provides a context-sensitive menu in the result field of a timeslot measurement window. Open the context menu by pressing the right mouse button.
The context-sensitive menu of the timeslot measurement window mainly covers configuration functions which alternatively can be accessed via the control panel, the menu
bar or the toolbar. The menu also consists of functions as for example "Show/Hide
Markers" or "Save Diagram". "Show/Hide Markers" provides a submenu to set markers
for display individually.

Figure 6-70: Measure > Numerical > Context-sensitive menu Tslot

The dialogs and parameters are described in the appropriate chapters of this operating
manual. The following table lists the context-sensitive menu items and refers to the
corresponding descriptions.
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Menu item

Described in ...

Print / Copy To Clipboard

Chapter 5.1.1.3, "Print or Copy to Clipboard", on page 49

Diagram Configuration...

Chapter 6.4.4.20, "Diagram Config. > Timeslot > Axes",
on page 157 and
Chapter 6.4.4.21, "Diagram Config. > Timeslot > Plot",
on page 158

Show/Hide Markers

Right mouse click shows or hides the markers.

Marker 1
Marker 2
Marker 3
Marker 4

6.4.4.6

Measurement Configuration > Continuous / Gate / Burst

Figure 6-71: Measure > Numerical > Meas configuration > Continuous / Burst / Gate

The "Duty Cycle" tab applies to "Continuous Av" measurement mode.

In a numerical measurement "Configuration" dialog, you can define up to four measurements. You can enable the measurement results for display, select the channel
and measurand and define additional parameters, like averaging or unit covered in
separate tabs.
Measurement
Indicates the measurement number.
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View
Selects the measurement to be viewed on the main numeric measurement window.
R&S NRPV views up to four measurements, including the absolute channel and maths
measurement.
Note: It is not possible, to check more than 4 views.
Channel
Selects a channel for numerical measurement. The list indicates all assigned channels
supporting numerical measurement.
If the connected sensor provides time gate measurement with the specified global
parameters, the application evaluates all selected channels.
Note: Channel duplication. In case the same measurement is assigned twice, an error
message appears.

It is possible to perform, for example, an average measurement and a peak measurement within the same channel.
Measurand
Selects the measurement parameter to be displayed.
Note: In case the same measurand is assigned to a second measurement in the same
channel, an error message pops up.
"Average"

Selects the average power for display.

"Peak"

Select the highest power measured.
Note: Peak is only available, if the sensor supports this feature.

Tabs
Besides the settings described above, the measurement configuration dialog covers
several tabs for setting further parameters, i.e.:
● Average parameters, see Chapter 6.4.4.8, "Measurement Config. > Averaging",
on page 147.
● Units, see Chapter 6.4.4.9, "Measurement Config. > Unit", on page 148.
● Relative measurement options and reference values, see Chapter 6.4.4.10, "Measurement Config. > Relative", on page 148.
● Auxiliaries, containing particular measurement values for display, see Chapter 6.4.4.11, "Measurement Config. > Auxiliaries", on page 149.
● Duty cycle settings for calculating the pulse power of pulse modulated signals, see
Chapter 6.4.4.12, "Measurement Config. > Duty Cycle", on page 150.
● Limit values, see Chapter 6.4.4.13, "Measurement Config. > Limits", on page 151.
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6.4.4.7

Measurement Configuration > Timeslot

Figure 6-72: Measure > Numerical > Meas configuration > Tslot

In this dialog, you can select the channel, measurand and timeslot, and define additional parameters, like averaging, unit or reference values.
Channel
Selects a channel for measurement. The list shows all assigned channels supporting
timeslot measurement.
Note: If the connected sensor provides timeslot measurement with the specified global
parameters, the application evaluates all selected channels.
Measurand
Selects the measurement parameter to be displayed.
Note: In case the same measurand is assigned to a second measurement in the same
channel, an error message appears.
"Average"

Selects the average power for display.

"Peak"

Selects the highest power measured.
Note: Peak is only available, if the sensor supports this feature.

Display Timeslots
Selects the timeslots that are to be displayed in the diagram.
Tabs
Besides the settings described above, the application provides several tabs for setting
further parameters:
● Averaging parameters, see Measurement Config. > Averaging.
● Units, see Measurement Config. > Unit.
● Relative measurement options and reference values, see Measurement Config. >
Relative.
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6.4.4.8

Measurement Config. > Averaging

Figure 6-73: Measure > Numerical > Meas configuration > Averaging

In the "Averaging" tab, you can activate automatic averaging mode and set the average filter count.
The "Ref. Timeslot" entry field applies to "Timeslot" measurement mode.

Auto
Determines the mode for calculating the average.
"On"

The sensor determines the optimum average filter count internally
based on the given resolution.

"Off"

The sensor uses an averaging factor you can set manually.

Count
Sets the number of measured values, which are averaged.
Directly entered, the value is rounded off to the closest power of two. Use the [up] and
[down] arrows to increase, or decrease the averaging count. Count is rounded to the
next higher or lower power of 2x values. The greater the averaging factor, the less the
measured values vary and the measurement time is even longer.
The R&S NRPV transmits the changes to the corresponding sensor, featuring the following configuration:
● Avg. count < Min.: sets averaging count to minimum and disables the decrement
button.
● Avg. count > Max.: sets averaging count to maximum and disables the increment
button.
Note: If Min or Max count are set automatically, no error messages are reported.
Ref. Timeslot
Defines the timeslot whose power is to be used as reference for automatically calculating the average count (auto averaging).
Note: Reference timeslot selection applies to "Timeslot" mode.
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6.4.4.9

Measurement Config. > Unit

Figure 6-74: Measure > Numerical > Meas configuration > Unit

The "Unit" tab of the numerical configuration dialog contains entry fields for assigning
the unit and resolution. You can view measurement and math results in linear scale
[Watt] or logarithmic scale [dBm].
Absolute
Sets the unit to display the absolute values of measurement.
"dBm"

Displays the absolute value as logarithmic power ratio.

"W"

Displays the absolute power value in Watt.

"dBµV"

Displays the absolute value of logarithmic power ratio, expressed as
a voltage.

Relative
Sets the unit to display the results of relative power measurement.
"1"

Displays the measured level related to a reference power.

"dB"

Displays the relative value as logarithmic power ratio.

"∆%"

Displays the power ratio of result and reference power, expressed %.
Note: When using percentages, differentiate between voltage or
power quantities, and consider the x% of a quantity, or x% more or
less of a quantity.

Resolution (dB)
Selects a resolution to display the results according to that value. R&S NRPV transmits
the changed resolution value to the sensor.
6.4.4.10

Measurement Config. > Relative

Figure 6-75: Measure > Numerical > Meas configuration > Relative
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The "Ref. Timeslot" selection field applies to "Timeslot" measurement mode.

In the "Relative" tab, you can set parameters for relative power measurement. A relative function calculates the power or the power ratio relative to a reference value. This
mode is useful for analyzing the stability or drift during power measurement.
If you perform a measurement with the math operation "SWR" (Standing Wave Ratio),
relative measurement is disabled, see Chapter 6.4.2.6, "Math Configuration",
on page 105.
Relative
Contains the parameters to configure relative power measurement.
"On"

Activates relative measurement. Based on the measured values
R&S NRPV calculates the relative values according to the reference
value. Relative measurement results as ratio in linear scale.
Note: SWR measurement mode disables relative measurement.

"Off"

Selects absolute measurement or measurement of the power ratio of
two measurements.

Reset
Accepts the currently measured value as reference value. This Reset button is enabled
when relative measurement is on.
Note: If the measurement result is invalid during reset function, an error message pops
up.
Ref. Value
Sets a new reference value directly, or modifies a previously set value.
Ref. Timeslot
Selects a particular timeslot for indicating.
Note: Reference timeslot selection only affects the settings in timeslot mode.
6.4.4.11

Measurement Config. > Auxiliaries

Figure 6-76: Measure > Numerical > Meas configuration > Auxiliaries
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The "Auxiliaries" tab applies to "Continuous, Gated and Burst Average" measurement
modes. "Timeslot" mode features a special display with settings defined separately.
The characterizing values in timeslot mode are described in Chapter 6.4.4.3, "Graph in
Timeslot Mode", on page 141.
In the "Auxiliaries" tab, you can select particular measurement values for display.
Besides the main readings, you can display up to three values in the result field.
1st. / 2nd. / 3rd.
Selects up to 3 parameters for display. The R&S NRPV calculates the following values
during measurement:
"Min"

The minimum value resulting from the measured samples.

"Max"

The maximum value resulting from the measured samples.

"Mean"

The mean value calculated from the measured samples.

"StDev"

The standard deviation calculated from the samples.

"Freq"

The frequency of the measured signal.

"Count"

The counted the number of samples.

"Av Count"

The number of readings to be averaged for one measured value.

"None"

none

Aux. Reset
Assigns the currently measured "Min", "Max", "Mean", "Num" and "StDev" values. The
"Reset" button is enabled if any of the auxiliaries entry fields is selected.
6.4.4.12

Measurement Config. > Duty Cycle

Figure 6-77: Measure > Numerical > Meas configuration > Duty cycle

This dialog only affects continuous average power measurement of pulse modulated
signals.
In this tab, you can activate the duty cycle correction. Using duty cycle correction, you
can determine the correction value as a percentage for pulse modulated signals. The
sensor calculates the pulse power from the duty cycle and the average power.
Correction
Activates duty cycle correction.
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"On"

Activates duty cycle correction for the corresponding sensor. If the
duty cycle is measured, the R&S NRPV displays the average power
of the pulse.
In the Info line of the measurement window, the symbol indicates
that global offset correction has been activated.
Note: If the duty cycle correction active, the entry field "Duty Cycle"
(%) switches to edit mode, and vice versa.

"Off"

Switches off duty cycle correction.

Duty Cycle (%)
Enters the value in percent. This entry field is enabled if duty cycle correction is activated.
6.4.4.13

Measurement Config. > Limits

Figure 6-78: Measure > Numerical > Meas configuration > Limits

The "Auxiliaries" tab applies to "Continuous, Gated and Burst Average" measurement
modes.
In the "Limits" tab, you can set an upper and a lower limit for each measurement result.
If one of the limits is exceeded, a warning is issued.
Upper / Lower
Activates the limit check.
"On"

Switches on the monitoring function for the upper limit or lower limit,
respectively.

"Off"

Switches off upper/ lower limit check

Upper/ Lower Value
Specifies an upper/lower limit for the measured values. If a limit is exceeded, the warning message "Limit fail" is displayed.
Warning Beep
Activates the acoustic alarm.
"On"

Activates an acoustic alarm for output if a limit is exceeded.

"Off"

Turns off the acoustic alarm.
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6.4.4.14

Math Configuration

Figure 6-79: Measure > Numerical > Math configuration dialog

R&S NRPV provides the "Math" functionality in the measurement modes continuous,
gate and burst.
R&S NRPV processes the results from several sensors, using mathematical functions.
The math configuration dialog provides configuration of up to four math channels for
multichannel measurement. Each of the four channels can be assigned to the same or
to different sensors. If multiple channels use the same sensor, the measurement is performed only once. The result is reused for the other channels. View selection boxes
activate displaying the measured and computed results of each math channels.
In this dialog, you can select the channel and measurand, or define additional parameters, as, for example, the unit, relative measurement option or auxiliaries, which are
covered in separate tabs.
Math 1 - 4
Indicates 4 available math measurements.
View
Selects the math channels to be viewed in the result field. R&S provides to display up
to four measurements, including absolute channel and math measurements.
Feed 1, 2
Selects a measurement for the first and for the second operand. The available absolute channel measurements are listed for selection.
"Feed 1"

Selects the channel to be used to calculate the displayed value.

"Feed 2"

Selects the second channel which is to be used for calculation.
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Operation
Selects a calculation function to operate the measurement results of feed 1 and feed 2.
If view is set, the corresponding math measurement results are displayed on the result
field.
"Ratio"

Builds the ratio of the power in the first channel to the power in the
second channel. Internally the ratio is performed by subtracting the
measured power values in logarithmic scale. Displayed unit is dB.

"Diff"

Subtracts the measured power in the second channel from the power
of the first channel. The calculation, performed in linear scale is converted to logarithmic scale. Displayed unit is dB.

"SWR"

Calculates the standing wave ratio from the first and the second measurement by using the following equation:
SWR = (1 + RC) / (1 - RC)
The measurement is performed in logarithmic scale.
Note: The forward power must be measured in the first channel and
the reverse power must be assigned to the second channel.
RC is the reflection coefficient, internally calculated from the measured power values P1 in channel 1 and P2 in channel 2.
RC = 10(P1 - P2) / 20

Tabs
Besides the settings described above, the math configuration dialog contains several
tabs, to set further parameters. The following chapters describe these settings:
● Chapter 6.4.4.15, "Math Config. > Unit", on page 153
● Chapter 6.4.4.16, "Math Config. > Relative", on page 154
● Chapter 6.4.4.17, "Math Config. > Auxiliaries", on page 155
● Chapter 6.4.4.18, "Math Config. > Limits", on page 156
6.4.4.15

Math Config. > Unit

Figure 6-80: Measure > Numerical > Math configuration > Unit

The "Unit" tab of the math configuration dialog contains the entry fields for assigning
unit and resolution to the results. You can view math results in linear scale [Watt] or
logarithmic scale [dBm].
Absolute
Sets the unit to display the absolute values of measurement.
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Note: Units for absolute measurement. According to relative measurement, selected
with math function ratio, the unit list changes to the appropriate relative units, described in section Relative (see below).
"dBm"

Displays the absolute value as logarithmic power ratio.

"W"

Displays the absolute power value in Watt.

"dBµV"

Displays the absolute value of logarithmic power ratio, expressed as
a voltage.

Relative
Sets the unit to display the results of relative power measurement.
Note: SWR measurement mode disables relative measurement.
"1"

Displays the measured level related to a reference power.

"dB"

Displays the relative value as logarithmic power ratio.

"∆%"

Displays the power ratio of result and reference power, expressed %.
Note: When using percentages differentiate between voltage or
power quantities, and consider the x% of a quantity or x% more or
less of a quantity.

Resolution (dB)
Selects a resolution to display the results according to that value. R&S NRPV transmits
the changed resolution value to the sensor.
6.4.4.16

Math Config. > Relative

Figure 6-81: Measure > Numerical > Math configuration > Relative

The "Relative" tab provides settings for relative power measurement. Data, resulting
from math operation can be related to a reference value.
Relative
Activates the relative function.
"On"

Activates relating function. Based on the calculated values
R&S NRPV computes the relative values according to the reference
value. Relative results are output as ratio in linear scale.
Note: SWR measurement mode disables relative measurement.

"Off"

Selects absolute output of math results.
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Reset
Accepts the currently calculated value as reference value. This "Reset" button is
enabled when relative function is on.
Note: If the measurement result is invalid during reset function, an error message pops
up.
Ref. Value
Enters a new reference value directly, or modifies a previously set value.
6.4.4.17

Math Config. > Auxiliaries

Figure 6-82: Measure > Numerical > Math configuration > Auxiliaries

In the "Auxiliaries" tab, you can determine math results for display. Along with the main
numeric value up to three values are displayed in the result field.
1st. / 2nd. / 3rd.
Selects up to 3 parameters for display. The R&S NRPV calculates the following values:
"Min"

The minimum value resulting from the calculated samples.

"Max"

The maximum value resulting from the calculated samples.

"Mean"

The mean value calculated from the calculated samples.

"StDev"

The calculated standard deviation.

"Feed 1 / Feed 2"
The values of feed 1 or feed 2 are used for calculating.
"Count"

The counted the number of samples.

"None"

none

Aux. Reset
Assigns the currently measured Min, Max, Mean, Feed, Num and StDev values. This
Reset button is enabled if any of the auxiliaries entry fields is selected.
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6.4.4.18

Math Config. > Limits

Figure 6-83: Measure > Numerical > Math configuration > Limits

In the "Limits" tab, you can determine an upper and a lower limit for each calculated
result. If one of the values is exceeded, a warning is issued.
Upper / Lower
Activates the limit check.
"On"

Switches on the monitoring function for the upper limit or lower limit,
respectively.

"Off"

Switches off upper/ lower limit check.

Upper/ Lower Value
Specifies an upper/lower limit for the computed values. If a limit is exceeded, the warning message "Limit fail" is displayed.
Warning Beep
Activates the acoustic alarm.

6.4.4.19

"On"

Activates an acoustic alarm for output if a limit is exceeded.

"Off"

Turns off the acoustic alarm.

Display Configuration

Figure 6-84: Measure > Numerical > Display configuration dialog

In this dialog, you can assign a name to the measurement window.
Name
Assigns a designated name to the appropriate measurement window.
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6.4.4.20

Diagram Config. > Timeslot > Axes

Figure 6-85: Measure > Numerical > Diagram configuration > Tslot > Axes

In the "Axes" tab, you can set the axis division, minimum and maximum power values
for the Y axis. The Y axis power scale is divided into 10 equal divisions. The y scale is
defined by two parameters, either by minimum and by maximum power or by minimum
power and power step per division. The entry fields provide the unit of measurement
selected in the unit tab. Alternatively, both values can be entered directly in the results
window of the timeslot measurement window. These settings only affect the graphical
data representation in the application and have no influence on the measurement or
sensor configuration.
Y axis
Contains the parameters for configuring the diagram axis for timeslot measurement.
Min Power ← Y axis
Sets the minimum level of the display.
Max Power ← Y axis
Enables the entry field to directly enter the maximum power value of the display. The
value defines the upper limit of the timeslot results window.
Power/Div ← Y axis
Enables the entry field to enter the power value of one division. The value, multiplied
by 10, the predefined number of divisions, defines the upper limit of the timeslot results
window.
Based on the power range of the sensor, Power/Div is validated featuring the following
configuration:
● Pow/Div < Min.: Minimum value is set per division.
● Pow/Div > Max.: Maximum value is set per division.
Note: In case of start value set automatically, no error messages are reported.
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6.4.4.21

Diagram Config. > Timeslot > Plot

Figure 6-86: Measure > Numerical > Diagram configuration > Tslot > Plot

Activates the view of gridlines in the diagram and assign a name to the measurement
window in this dialog.
Name
Applies a designated name to the timeslot measurement window.
Grid lines
Sets grid lines to be displayed or hidden.
6.4.4.22

Measurements Panel > Timeslot

Figure 6-87: Measure > Timeslot

The measurements panel shows power values measured in timeslots. Activate the
timeslot for display in the measurement configuration dialog, as described under Chapter 6.4.4.7, "Measurement Configuration > Timeslot", on page 146.
<channel>
Displays the parameters average, peak and the ratio of average to peak of the corresponding channel.
M1 (#1)
Displays the values of the appropriate channel measured in the selected timeslot.
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6.5 Recording
It is often useful to record measured data, to analyze a signal in more detail after the
measurement, or to detect any irregularities that occurred over a longer period. Using
the recording function of the R&S NRPV, you can trace numerical measurement data
over a period of time. It is especially designed for long-term measurements.
A graphical representation allows you to view and check the current signal characteristics quickly. You also can write the readings directly to a file. Each recorded track is
stored in a separate file in *.csv format. Since many programs can read *.csv files,
in particular spreadsheet programs, you can evaluate your measurement later.
You can select up to four parameters from a numerical measurement panel for recording. During long-term recording, the function displays data in compressed form. Thus
you can monitor the measurement data continuously.
Interactions and characteristics
●

Recording can only be started when the associated measurement is running.

●

If recording is stopped and restarted, previous values are discarded and get lost if
they have not been saved to disk manually before restarting.

●

Switching to another measurement window stops the measurement, and consequently the associated recording.

●

Prerequisite for the recording is that you have previously configured the measurement. How to setup, for example a continuous average measurement, see Chapter 4.3.3, "Measuring the Average Power", on page 33.

●

The format of the recorded data is ASCII format, with a semicolon used as delimiter.

Preparing for recording
► To open the recorder window, perform one of the following:
●

In the menu bar, select "Measure > Data Recorder"

●

In the toolbar, select the recorder icon

.

The "Recorder" window opens.

User Manual 1173.0314.02 ─ 07

159

R&S®NRPV

Settings - GUI Reference
Recording

Figure 6-88: Recorder window

The window is tiled into four panels, according to the four tracks that can be recorded per numerical measurement window.
Selecting the parameters to be recorded
You can only select a parameter for recording, if the measurement is not running.

The following example shows how to perform the recording and how to store the recorded values to the hard disk.
To enable a parameter for recording, switch to the associated measurement window:
1. In the "INav" panel of the "Continuous Av" window, open the context-sensitive
menu.
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2. Select "Record" and the respective parameter in the submenu, for example "INav".

Each panel provides the appropriate parameters for the recording.
Once a parameter is checked, the R&S NRPV assigns this parameter to a panel in
the "Recorder" window.

3. Repeat these steps for the parameters you want to record.
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You can assign up to four parameters to a recorder. The assignment of the panels
corresponds to the order of your selection.

Figure 6-89: Recorder > Selected parameters

The "Recorder" window assigns the selected parameter to the recorder panel, and
indicates the corresponding measurement panel.
Start recording
To start recording, perform the following steps:
1. In the toolbar, start the measurement

.

2. If you want the R&S NRPV to write the recorded measurement results to the hard
disk simultaneously, check
in the "Recorder" window.

The R&S NRPV indicates a file name that is automatically generated for the storage of the records.
"Record to Disk" writes the data of each active recording panel (a so-called track)
in ASCII format to the hard disk. When recording is started, the R&S NRPV automatically creates one file per recorder panel in the %APPDATA% path of the computer, that is %APPDATA%\Rohde-Schwarz\NRPV\Recording. The automatically assigned file names have the structure:
REC_<year><month><day><timestamp>_Track<1...4>.csv
Tip: If you did not activate "Recording to Disk", you can still save the recorded data
manually after recording. In this case, the R&S NRPV stores the video data, which
means the compressed values, as shown in the recorder window. The longer the
recording is in progress, the higher the degree of compression.
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3. Start recording

.

In the recorder window, you can see the progress of the measured parameters
over time. The R&S NRPV compresses the readings in particular time intervals by
grouping several values. It enables the application to show the measurement
results in the recorder window continuously.
Table 6-6: Displayed progress of the recording

Stop recording
You can either stop recording manually, or the R&S NRPV stops recording automatically when there is insufficient storage space on the hard disk.
To stop recording manually:
► Select
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Elements and controls in the recorder window
You can perform various settings in the "Recorder" window that are not apparent at first
glance. This description briefly explains the functional elements.

Figure 6-90: Recorder > controls
1
2
3
4
5
6
7

=
=
=
=
=
=
=

measured parameter (measurement panel number)
graph
Y-axis and unit
scrolling, shown when the mouse cursor is in this area
time scale in seconds
zooming
indication of the recorder panel with keyboard focus

Table 6-7: Elements and controls in the recorder window
Legend

Item

Interaction via ...

Description

1

Name of the panel

—

Indicates the
parameter that
is recorded,
and the measurement
panel it
belongs to.

2

Graph

(see zooming)

Shows the
progress of
the measured
values graphically (over
time).
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Legend

Item

Interaction via ...

Description

3

Y Axes

Mouse ( , see scrolling)

Scales the
axis according
to the characteristics of the
parameter and
shows the unit
of the measured values.

4

Scrolling the Y Axis

●
●

●

Mouse pointer
Cursor keys
([Up] arrow / [Down] arrow)

●

Scrolling the X Axis

●
●

Mouse pointer
Cursor keys
([left] arrow / [right] arrow)

●

●

5

X Axis

Mouse (

6

Zoom

●
●

–

View entire curve

[Pos1] key
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Mouse pointer
Cursor keys in combination with
the [CTRL] key:
–
[CTRL]+[up ] arrow
–
[CTRL]+[down] arrow
–
[CTRL]+[left] arrow
–
[CTRL]+[right] arrow

Shift the
graphic
along the
Y axis up
and
down.
When the
pointer
becomes
a , use
the
mouse to
scroll the
axis.
Shift the
graphic
along the
X axis to
the left
and right.
When the
pointer
becomes
,
a
use the
mouse to
scroll the
axis.

Indicates the
recording time
in seconds.
Drag a rectangle to select
the region you
want to zoom
out.

Sets the panel
display to its
original size.
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Legend

Item

Interaction via ...

Description

7

Panel focused

—

Indicates that
the panel has
keyboard
focus. Navigation and
zooming is
enabled.

Panel not focused

—

Indicates that
the panel does
not have keyboard focus.
Navigation
and zooming
is locked.

Evaluating recorded data
If you have recorded and saved your measurement, there is at least one *.csv file.
You can open a *.csv file with a suitable program, for example with a spreadsheet
program.
Notes to the program you use for evaluation:
●

The storage format of the recorded data is ASCII format, with a semicolon ";" as
delimiter. Keep in mind that the program you are using may use a different delimiter.

●

The R&S NRPV stores the recorded values in the decimal format according to the
regional options of your computer.
This means if you want to evaluate the data on another computer, for example, the
setting of the numerical format can be different.

●

The number of columns and rows of the spreadsheet program that you are using
could be limited. In particular, if you have performed a long-term measurement, the
program might not be able to load the *.csv file completely. To fix this problem,
open the source file in a text editor. Save the source file as several smaller files
that conform to this row and column limit.

If you have recorded the measurement to the hard disk by activating "Record to Disk",
the R&S NRPV stores one file per recorded track. It automatically assigns a file name
consisting of a time stamp and the recorded track.
If you have saved the file after recording using "Save Data", no file name is created
automatically, but an interactive "Save File" dialog opens and you can assign a suitable
filename. The first line in the file provides information on the measured parameter and
a time stamp.
A file contains the measured value pairs as ASCII strings, separated by a semicolon.
Depending on the used program, the values are automatically converted and displayed
as a table when you open the file. The following description refers to MS®EXCEL. If
you use another program, the names of the mentioned commands and functions may
differ slightly.

User Manual 1173.0314.02 ─ 07

166

R&S®NRPV

Settings - GUI Reference
Zero

If the data is not displayed numerically, convert the ASCII strings manually:
1. Select "Data Text to Column", or a similar command, to convert the text format to
numerical format.
2. Select ";" as delimiter and
In numerical format, you can display the results in an appropriate graph, for example an X/Y diagram, to analyze and evaluate the measurement.

6.6 Start / Stop Measurement
Start
Starts the measurement in the currently active window. This button is disabled if the
measurement is running.
Note: The start command activates all the measurements, but only the measurement
in the active window is performed. The others are pending. If you switch to another
measurement window, the R&S NRPV automatically performs this one. The previously
active measurement is now pending.
Stop
Stops all active measurements.

6.7 Zero
Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor (see tips below). R&S power sensors automatically detect the presence of any significant input power. It aborts zeroing and generates an error message.
Zeroing can take a few seconds, depending on the sensor model; refer to the documentation of your external power sensor for more information.
► To determine the sensor, select "Zero > Select > Channels > <channel>" in the
R&S NRPV menu bar.

Figure 6-91: Zero menu
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The selection automatically activates zeroing. The function checks the confidence
level of the sensor results.

Figure 6-92: Zero in process

This process can take a few seconds. During this time, the R&S NRPV displays the
status of the process in the "Zero" window. When completed, the message terminates zeroing successfully or reports an error (succeeded / failed).
Tips for zeroing
Zeroing should be performed:
●

During warm-up after switching on or connecting the instrument.

●

After a substantial variation of the ambient temperature.

●

After fastening the power sensor module to an RF connector at high temperature.

●

After several hours of operation.

●

When low-power signals are to be measured, like signals with less than 10 dB
above the lower measurement limit.

Switch off the RF power source for zeroing; do not disconnect it from the sensor. In this
way you will maintain the thermal equilibrium, and zeroing will also compensate for the
noise superimposed on the measured signal (for example from a broadband amplifier).

6.8 Window

Figure 6-93: Window menu

This menu contains functions for window handling.
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Tile
Arrange all currently opened windows on the screen. The window being last active
continues to hold focus. Tiling maintains the display aspect ratio of the windows.
Note: When the measurement windows are tiled, the trace window only shows the diagram area. The control panel and the measurement panel are hidden.
Cascade
Arrange all currently opened windows successively. The currently focused window
remains in the same state. Cascading maintains the display aspect ratio of the windows.
Activate Next
Sets the following window active.
Activate Previous
Sets the previous window active.
Close
Quits the currently active window.
Close All
Quits all opened windows simultaneously.

6.9 Help

Figure 6-94: Help menu

The "Help" menu provides access to the help system of the R&S NRPV.
Index...
Use for help. Search for specific words or phrases, or choose from a list of keywords.
Open the HTML document in a browser, e.g. Microsoft®Windows Internet Explorer.
Note: Currently, the Index function is not active. This function is intended for future
use.
About...
Retrieves information about software version and licensing of the R&S NRPV.
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Figure 6-95: About R&S NRPV
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7 Appendix
Appendix provides a list of warning messages and makes familiar with the conventions
used in this manual. It also covers information on software licensing and R&S information for customer support and service. A step-by-step description for generating a
GSM/EDGE signal supports getting started with performing a continuous average measurement.

7.1 Warning Messages
Another instance invoked

Only one instance of R&S NRPV can run at a time. The program cannot be started
twice.
Maximum number of viewable channels is 4.
More than 4 measurements were activated.

Up to four measurements, including the absolute channel and maths measurement are
possible.
Duplicate channels cannot be selected
A channel was assigned to a second measurement using the same measurand.

E.g. with one sensor connected, an average measurement cannot be performed parallel on a second channel.
Error 89: Record variable duplication. Duplicate variables cannot be recorded
The same record variable was assigned to a record trace.
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Error 91: Channel duplication. Duplicate channels cannot be selected
The same trace measurement was assigned to a second trace channel. E.g. with one
sensor connected, an average trace measurement cannot be performed parallel on a
second trace channel.

Reference value cannot be calculated
The current measurement result is invalid. Therefore the derived reference value on
pressing reset will also be invalid.

Recording is in process
The application is currently recording the measurement. Prompt with Yes to abort
recording. With No recording will proceed.
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Index
A
Absolute/Relative
Unit in trace diagram ................................................. 108
Accessories
System setup ................................................................ 9
USB adapter cable ........................................................ 9
Activate selected communication standard ....................... 91
Active fence ................................................................. 86, 87
Active power ...................................................................... 30
Add /Remove marker
trace diagram ............................................................ 116
Algorithm ........................................................................... 89
Alphanumerical entry field ................................................. 65
Application cards ................................................................. 5
Application notes ................................................................. 5
Application window ............................................................ 51
Diagram ...................................................................... 53
Menu ........................................................................... 51
Menu bar ..................................................................... 51
Status bar ................................................................... 51
Toolbar ........................................................................ 51
Apply ................................................................................. 65
Auto equivalent sampling .................................................. 89
Auto ranging ...................................................................... 80
Auto trigger level ............................................................... 92
Automatic averaging ......................................................... 81
Continuous .................................................................. 81
Fixed noise ................................................................. 81
Max. settl. time ............................................................ 81
Noise content .............................................................. 81
Average power
Trace diagram ........................................................... 113
Averaging count
< Min ......................................................................... 104
> Max ........................................................................ 104
Trace ......................................................................... 104
AWGN
Statistics ................................................................... 136

B
Base power
Trace diagram ........................................................... 113
Basics on power measurement ......................................... 29
Brochures ............................................................................ 5
Burst .................................................................................. 96
Dropout ....................................................................... 84
Exclude from end ........................................................ 84
Exclude from start ....................................................... 84
Burst average
Configure .............................................................. 72, 84
Buttons .............................................................................. 65

C
Cancel ............................................................................... 65
Channel ....................................................................... 77, 82
Trace ......................................................................... 104
Trigger settings ........................................................... 92
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Re. source .................................................................. 79
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S-Parameter correction ............................................... 79
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Video bandwidth ........................................................ 78
Check box ......................................................................... 65
Color selection field ........................................................... 65
Color settings .................................................................... 75
Communication and standards ......................................... 90
CW signal ................................................................... 90
Default ........................................................................ 90
Standard ..................................................................... 90
Configuration dialog .......................................................... 55
Configure ........................................................................... 70
Activate selected communication standard ................ 91
Active fence in gates mode ......................................... 87
Active fence in timeslot mode ..................................... 86
Algorithm ..................................................................... 89
Aperture continuous .................................................... 83
Aperture statistics ....................................................... 85
Auto equivalent sampling ............................................ 89
Auto ranging ............................................................... 80
Automatic averaging ................................................... 81
Burst average ....................................................... 72, 84
Channel ...................................................................... 77
Channel assignment ............................................. 72, 75
Channel burst ............................................................. 84
Channel continuous .................................................... 83
Channel frequency ...................................................... 82
Channel name ............................................................ 76
Channel settings ................................................... 72, 76
Channel statistics ........................................................ 85
Color settings ........................................................ 71, 74
Communication and standards ................................... 90
Connectivity ................................................................ 76
Continuous ............................................................ 72, 83
Crossover ranging ...................................................... 80
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Distal ........................................................................... 90
Dropout in burst mode ................................................ 84
Dropout trigger settings .............................................. 93
Exclude from end in burst mode ................................. 84
Exclude from end in timeslot mode ............................. 86
Exclude from start in burst mode ................................ 84
Exclude from start in timeslot mode ............................ 86
Fence length in gates mode ....................................... 87
Fence length in timeslot mode .................................... 86
Fence locked in timeslot mode ................................... 86
Fence start in gates mode .......................................... 87
Fence start in timeslot mode ....................................... 86
Gamma correction ...................................................... 79
Gate length ................................................................. 87
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